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Welcome to Clooz! 

Welcome to the Clooz family.  We’re glad you’ve joined us.  Sit and visit awhile.  We are proud to 

provide you with an upgraded and easier to use version of our tool supporting genealogy research, 

Clooz 3!  Clooz will help you organize your stacks of family history records, documents, 

photographs, and notes so you can find something quickly.  Even more important, Clooz will help 

you organize and review the information contained in these documents to begin the process of 

sorting out which people belong in your family tree. 

You—our users and friends—are very important to us.  Like a close-knit family, we’ll give you 

personal attention and communicate often in several ways.  If you want to learn how to use Clooz, or 

just see the latest Clooz news, visit the Clooz home page (http://www.Clooz.com) and sign up for 

our online mailing list.  

Best of all, we are as close to you as your computer.  If you’ve got a problem, send us an e-mail and 

you’ll get a prompt reply.  In fact, it’s as easy to contact us as calling your sister, brother, or other 

family member.  No red tape or endless phone menus.   What’s more, these services are free for 

registered users. 

Like the world of genealogy, Clooz is changing. Version 3 contains many new features and revisions 

that you’ll discover here.  If you have suggestions for changes, additions, or ideas for future 

upgrades to Clooz, feel free to send them to us by email at ideas@clooz.com. 

We hope you enjoy Clooz.  We are so proud of it we provide a money-back guarantee for CD 

purchases through the Clooz website.  Now isn’t it time to stop postponing organizing your family 

records and start using Clooz today? 

  

http://www.clooz.com/
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Clooz Online Resources 
 

 

Clooz Home 

Page 
http://www.Clooz.com 

Clooz Training 

Videos 
http://clooz3videos.ancestralsystems.com 

 
http://www.facebook.com/cloozbyancestralsystems#!/AncestralSystems 

 
https://twitter.com/CloozJoe 

Clooz User’s 

Forum on 

RootsWeb 

http://lists.rootsweb.ancestry.com/index/other/Software/Clooz.html 

  

http://www.clooz.com/
http://clooz3videos.ancestralsystems.com/
http://www.facebook.com/cloozbyancestralsystems%23!/AncestralSystems
https://twitter.com/CloozJoe
http://lists.rootsweb.ancestry.com/index/other/Software/Clooz.html
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The Clooz approach 

In order to understand how to best use Clooz, you will need to understand the Clooz approach.  

You’re probably familiar with genealogy software programs.  You enter the names and pertinent 

information about people in your family. That is a lineage-linked program.  Clooz is a genealogy 

utility program.  You enter documents (that contain people), so it is called a document-based 

program. 

Each record in Clooz is treated as a unique entity.  A marriage certificate is one record; a will is one 

record; a census of one family is one record or a census of an entire municipal area is one record as 

long as the same enumerator recorded the information.  Each of your records needs to be viewed first 

from the vantage point of the record itself, not the people contained in the record.  For instance, 

Clooz identifies a census record by its year, geographic location, and supervisor’s and enumerator’s 

district (if applicable).  That information is the same for every person on that page of the record. 

You take four major steps to enter information into Clooz: 

First, examine your existing family tree and research files to identify any documents which might 

not have been fully analyzed, or areas where additional research is needed.   Use the Clooz Research 

Log to organize your research tasks.   Once a document has been found, it’s ready to be entered into 

Clooz. 

Second, create a Clooz record from your actual document.  If it’s a census record, you would select 

the country and census year from the explorer bar on the left side of the screen, and then add location 

information onto the main census form.   The source of the document should be recorded, and any 

digital files you created or obtained relating to the document can also be attached to the document 

record for easy retrieval and viewing. 

Third, add details about each person from that record.  The information pertaining to each person is 

linked to an individual in Clooz’s list of people.   You could select the person to link to the 

document manually (before entering their details), or let Clooz automatically create a new person in 

the database based on the personal information entered from the document (requires a name be 

entered). 

Fourth, save the document and people associated with it.   Use the report generator to analyze the 

data in many different ways.   If you let Clooz generate new people from each document entry, you 

could then merge together the records of people once you can accurately determine they are in fact 

the same person. 

In a nutshell, that’s the Clooz approach, and it applies to all the records you put in Clooz.   You no 

longer need to load up your lineage-linked database with people that might possibly be your relative.   

Let Clooz be the repository for all your documents, and move the appropriate people to your family 

tree after doing a proper analysis.  
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What’s new in version 3? 

Clooz version 3 includes some significant changes to its user interface, making it much more flexible 

and easier to use than previous versions.   We have strived to make the program more useable, 

without having to change your work habits.   Clooz now provides better support for the paperless 

work environment, while maintaining its longstanding features for organizing physical files.  For 

those who are upgrading from previous versions of Clooz, your existing data will be upgraded to the 

new format, now a single database file (.cdb extension), still in the Microsoft Access 2003 format.  

 

Composite View 
Introduced in Clooz version 3.2, the Composite View is a hierarchical display of data records on the 

main screen which visualizes the links between people and documents, between documents and 

sources, between sources and repositories, and in fact, between nearly all the ways data in Clooz are 

linked together.   It is a great way of analyzing your data.   You can easily toggle the main screen 

back and forth between the original grid layout, and the new Composite View. 

 

Figure 1  - Composite View 
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Improved data import and export capabilities 
Version 2.1 had established the shared use of a database file (.fdb) with Legacy Family Tree 

software.   To provide more flexibility and simplicity, once the older database files are upgraded to 

version 3, all of your Clooz data will be in one file (.cdb).   In version 3, data importing was given a 

substantial overhaul.  Clooz now allows you to directly import individual and source information 

from the latest versions of Legacy Family Tree, RootsMagic, Family Historian and The Master 

Genealogist data files.   Data from other programs (such as Family Tree Maker) can be imported 

using GEDCOM files.  In each case, you are able to control the selection of which people should be 

imported from the other file.  There is also now the capability to merge two Clooz databases. 

 

Figure 2 - Data Transfer Manager Window 

The new Data Transfer Manager has replaced all of the version 2.1 GEDCOM import options, and 

eliminates the decisions you previously had to make regarding interfacing to Legacy Family Tree 

software.  Therefore, the opening menu to select actions has been simplified.   New databases always 

start empty.   You can selectively import whatever records you choose using the Data Transfer 

Manager.   Clooz will automatically prompt you to upgrade a file if you attempt to open a database 

from an older version. 
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Export Documents to Other Programs 
Version 3.3 of Clooz implemented a whole new level of export capabilities to Legacy Family Tree.  

Export support to RootsMagic, FamilyTreeMaker, and The Master Genealogist (via GEDCOM) was 

added in versions 3.4, and Family Historian in version 3.5.  This export capability takes a Clooz 

document in the form of all the people linked to the document, the source (and repository) for the 

document (with all attached media images), and then automatically generates events for each of the 

people which are supported by the data in the document.  For example, consider a census document 

for which you have entered all the details shown on the census form for each person in a family.   

When exporting the census document to Legacy, Clooz will add the people in Legacy (or use 

existing people in Legacy if links have been established), and then create the census event in Legacy 

for each person.   It then generates other events supported by the data in the census, such as birth 

dates (based on person’s age at the enumeration date), residence (containing the street address if 

entered on the census form), occupation, etc.   Then the source for the census is automatically cited 

for all of these events.  Various media files and images that you had linked to this census document 

in Clooz will be attached to the events, source details, and source in Legacy.   All of this occurs with 

the click of one export button.   When exporting to other programs using GEDCOM files, you 

designate the name of the GEDCOM file to be produced and then import it into the other program 

using its import or merge capabilities.  Other than that, the process is similar.  Of course you are left 

in complete control of which details get exported using the features on the Document Export form. 

 

Figure 3 – Document Export Form 

It is even possible for you to designate the parent-child relationships and build families so that the 

exported persons are properly linked when they appear in the other program. 
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New document templates and reports 
Clooz version 3 includes templates and matching reports for several censuses released to the public 

following the previous Clooz version: 

1940 US Census 

1911 UK Census 

1916 Canada Census 

 

Better handling of digital files and URLs 
Version 3 of Clooz now allows you to attach multiple files or URLs (Internet website addresses) to a 

single document or source record.   You can select which image should appear on the template form 

when viewed on the screen or in certain reports.   Digital files attached to documents can also be 

given unique descriptions.   Attaching the files to a Clooz document couldn’t be easier.   Clooz now 

supports drag and drop mouse operations between Windows Explorer (My Computer) and the digital 

files list.   You just click on the desired filename and drag it into Clooz.   Copy/Paste clipboard 

operations are also supported.   In a similar way, you can record an online document’s URL by 

simply clicking on the browser’s small icon by the web address and dragging it into Clooz’s digital 

files list. 

 

Figure 4- File and URL Tool 

To better organize digital files, an option was added to specify a root directory which contains some 

or all of the digital files attached to your Clooz document records.   Those files located within this 

directory structure will list an abbreviated file path, where “…\” appears in place of the longer root 

directory path.   Digital files not saved within this directory structure will show their own full path 

name. 

Improved tools for identifying and locating people 
A new column was added when displaying lists of people showing other surnames used for that 

person.   Each time a person is linked to a document, the details for that person include the given 

name and surname as it appeared in the document.   The ‘other surnames’ field is a list of all the 
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unique spellings used, as well as married names.   The list is maintained automatically by Clooz 

based on the document details you enter.   Married names can also be added in a person’s vital 

details. 

 

Figure 5- Other Surnames Column 

 

A new toolbar was added to the main window of Clooz to allow you to easily enter some search 

criteria to either find the desired person (or whatever is being listed) or filter the list to only show a 

subset of the data.   For instance, with the list of people displayed, the default column setting is 

Surname, Given Name and Starts With.   If you enter “th, r”, and click the Find button, you would 

jump to the first person whose surname started with “Th” and had a given name starting with “R”.   

If you had just entered “th”, without the comma and given name or initial, Clooz will search the 

surnames alone.   Finally, Clooz provides even more advanced combination searches using the 

advanced Find and Filter capabilities accessible through the down arrows on the Find or Filter 

buttons. 

 

Figure 6 - Search Tool Bar 

 

Improved addition and handling of people 
 

In previous versions of Clooz, you had to link a person to a document before entering their details.   

Before linking, this person had to already exist in the database, or be added at that point.   You no 

longer have to go through those extra steps (although you still can if you wish).   Each document 

type allows you to just fill in the document details for another (new) person.   Clooz then takes the 

information you entered (which includes Given Name and Surname), and creates the new person 

record and sets up the link, all in one step.   You can now take a document and enter its contents in a 
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sequential way without having to prejudge who the right person is in your database that matches the 

one in that document.    

 

 

Figure 7 – Button for Adding a New Person Based on Document Details 

If you think about this for a second, you are probably wondering how you deal with the multiple 

names for a person that might accumulate if they appeared in several documents, and the New person 

feature was used in each case.   Clooz 3 provides the capability to merge multiple records for people 

into one person record, and to clone a person (which, with further editing of the original and cloned 

records, would be used to separate the data for a person into different people; undoing erroneous 

links). 

 

Figure 8 - Menu Item to Merge People 

 

These capabilities not only make Clooz more flexible and easier to use, but better support best 

practice research techniques.   Decisions on whether people listed in various documents are in fact 

the same person should be done after careful analysis.  Clooz allows the researcher to maintain them 

separately in the database until they can confidently merge them (or keep them separate). 
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Faster capture of source information 
Templates for entering source information for the document records entered were added in Clooz 2.   

However, in the excitement of finding new documents and entering their information, a common 

shortcut used by the casual researcher is to skip over the entry of source information.   This omission 

of information later proves to undermine or destroy the credibility of the information that was 

entered.   Clooz 3 addresses this by making it easier to record the source information using a new 

feature called the Quick Capture text box.   Each of the source templates now allows you to highlight 

source information, say on an online data repository web site, click on it and drag it from your 

Internet browser right into Clooz (copy/paste could be used the same way).   It is then captured 

within that source record, where you can then further dissect it into its component part and 

copy/paste into the appropriate template fields for proper formatting.   If you are not sure the 

document is meaningful, you could delay the reformatting until a later time so long as you are sure 

you have captured all the source information you’ll need. 

 

Figure 9 - Quick Capture of Source Information 

 

Improved flexibility of use 
Clooz version 3 is now designed to provide you better options and tools to use it in whatever way 

you need it to.  Prior versions tended to push certain workflows and data organization patterns.   This 

is no longer the case.   Fields like the Personal File Number are still there to support physical file 

organization and locating, but it is now optional, and no longer is required to be unique.     

Previous versions of Clooz required you to go to a certain list or place in the program to edit items 

such as documents, sources, and repositories.   Access to many of these editors is now available in 

multiple places.   To edit a census document, you can do it from the main list of censuses (as with 

prior versions), or from the list of censuses that appears within a person’s details (i.e. the list of 

censuses they appeared in).   Repositories can be edited from the list of repositories, or from where 

they appear in the source form.   All of these changes are designed to provide you access to what you 

need at the point where you need it, eliminating extra keystrokes and time of exiting out of one thing 

to get to another. 
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In previous versions, Clooz would always open in full screen mode.   Clooz 3 opens in the same 

state (maximized, normal, minimized), location and size as it was displayed when it was last closed. 

Clooz 3 allows improved sorting capabilities for people in documents.   For instance, you can now 

sort on page and line numbers for display of people in census documents to have them appear in the 

order in which they appeared in the census. 

Many of the data entry fields will automatically capitalize the first letter (such as M or F for sex). 

An additional drop down list was added to support census relationships (to Head of Household). 

Editable combo boxes (with drop down lists) now support copy/paste clipboard operations. 

 

 

New capabilities to edit lists 
Most of the lists in Clooz (that appear in dropdown selection lists), are generated through 

accumulated user input.   This often leaves you with misspellings or duplicate entries.   Clooz 3 

solves that by allowing you to merge together multiple items in a list.   Together with add and delete 

capabilities, you can customize your lists to suit your personal situation.  A Check Usage feature is 

useful when identifying where a list item is used. 

 

Figure 10 - Context Menu Functions Supporting List Editing 

 

 

 

Figure 11 - List of Occurrences for an Item 
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Improved Report Generation 
Report generation in Clooz version 3 has been improved through optimization of the database 

activity in collecting the data for the report.   This results in faster appearance of the report you wish 

to view.   Numerous other small corrections were made to the report templates or data. 

 

 

Automatic online updates 
No software is perfect, and issues will always be a fact of life.   However, Clooz version 3 contains 

an updating capability to download the latest updates to the software.  This gets you fixed and 

updated in short order.   Likewise, smaller improvements can be distributed without waiting for the 

next major version.   An option exists for you to turn off the automatic check that otherwise occurs 

each time you start Clooz.   You can also manually request a check for updates at any time.  Updates 

will not be installed in any case without your approval at the time.    

 

Figure 12 - Popup Window When an Update is Ready 
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Clooz Features 

Clooz Main Window 
Navigating around Clooz is fairly straightforward.   All of the features available in Clooz can be 

easily reached from either the Clooz Explorer Bar or the Clooz Menu Bar.   

 

 

Figure 13 - Clooz Main Window 
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Explorer Bar 
The Clooz Explorer Bar is on the left side of the Clooz screen (see Figure 14), and will be your 

primary tool in navigating through your data stored in Clooz.  From here, you can access the forms 

you need to enter people, businesses, buildings, censuses, census substitutes, documents, images, 

sources, and research logs.  Click on any of those choices and that category opens up to show you 

the forms available for data entry.  For the people, businesses, buildings, research log, and 

repositories categories, the only choice available from the explorer bar is to add a new record.  The 

rest of the categories on the explorer bar have specific forms to choose from for your data entry.  

You should see entries to the right of the explorer bar in the grid for that category, if you have data 

entered under that category.  This is where you will see all of the entries you have entered thus far. 

When you change to a different category by clicking on one of the 

choices in the explorer bar, the category you were in will collapse and 

the new category will expand to show the choices available there. 

The four choices at the bottom of the explorer bar—lists, repositories, 

reports, and External File Links—are different than the other 

categories. The Lists category allows you to edit any of the drop-down 

lists that are available within Clooz. Sometimes our fingers get away 

from us on the keyboard and we have misspellings that remain in the 

dropdown lists until corrected.  Click on Lists, find the list you want to 

edit, and select it.  A screen will pop up with all the entries for that list. 

There are instructions on that screen for adding, editing, and deleting 

items. 

Repositories can be added in Clooz when you’re working in the Source 

forms, or you can add them from the explorer bar. If you need to edit a 

repository after it has been entered, you would do so by selecting 

Repositories from the explorer bar and finding the repository to edit on 

the Repository grid, or by the context menu (right-click) off a 

repository referenced by a source (source window). 

If you converted your database from Clooz 1.x, your repositories will 

be in the list here, but you might want to check each one because only 

the repository name was converted, not an address or other location 

information. 

When you click on the Reports category, the Reports screen will open. 

You can also see the Reports screen by clicking on Reports from the 

menu bar on top. 

Finally, the External File Links category displays a list of other files 

from which you have imported data.   Selecting a database name in the 

list will reopen the Data Transfer Manager with that file. 

 Figure 14 - Explorer Bar 
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Menu Bar 
Clooz has a menu bar along the top of the screen providing access to many of the program’s 

features. If an item on a menu is greyed out, it is not available to you in the screen you are in 

currently.   Most Clooz functions are only enabled when a database is open.  

 

Figure 15 - File Menu 

From the File menu, you can create a new database (blank), open an existing database (if it is not the 

current version, Clooz will prompt you to update it), or close a database.   The Import / Merge 

Databases menu item leads to a further list of possible sources to input from.   Importing will be 

covered in detail later.  Menu items to archive your database, restore an archived database, or 

compact a database are also provided.   The Maintenance item contains a command to reset the main 

Grid configuration if the Grid is not being displayed properly.  Of course, you can use this menu to 

exit the program.  Additionally, the last four databases you have used will be listed at the bottom of 

the File Menu so you can quickly select the database you want to open. 

 

Figure 16 - Edit Menu 

The Edit menu allows you to Edit Lists, perform search and filtering functions, and change the 

program options.  In the Options window, you can choose how to open Clooz, either with the 

database you used last time you were in Clooz, or you can select the database you want to use each 
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time Clooz opens.   These and other settings in the Options window will be covered in detail in a 

later section. 

The Clooz menu lists all of the same categories as shown in the Explorer Bar.   Likewise, the 

Reports menu item opens the Report window (same as pressing the Reports button in the Explorer 

Bar. 

The Help menu items include the Clooz Help (this manual), and links to various websites where you 

can obtain additional information.   There is an item to let you enter your serial number, as well as 

manually request Clooz to check if any updates are available.   It would not be necessary for you to 

check for updates unless you turned off automatic updates in the Options window.   Finally, like 

most Windows programs, the About window can be displayed, which is the way you could see 

which version of Clooz you are using. 

 

Figure 17 - Help Menu 

 

Main Display Area 
The large area of the main screen contains either the Grid View or the Composite View.   The 

selection between the two views is made using a button on the Search Tool Bar, located at the top of 

the display area. 

Grid View 

The large grid of data comprising most of Clooz’s application window is used to display list of 

people, businesses, buildings, documents, sources and repositories according to what you have 

selected in the Explorer Bar.   The default display when a database is first opened is the People 

display.   Clicking on another button in the Explorer Bar will display the data associated with that 

category.    
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Figure 18 - Grid Column Resizing 

You can customize the column sizes, position order, and sort order for the data for the grid 

associated with each of the data categories.   These settings are saved automatically when you exit 

Clooz, and can only be reset to the initial default position by using the Reset Grid Layout Settings 

button in the Options window (Edit Menu).  You can change the size of the columns by hovering the 

cursor between the column header labels until a cursor appears with arrow points on both ends of a 

horizontal line.  Clicking and dragging at that point will change the width of the columns.   

The small triangles on the right side of some of the column headers indicate which columns are 

controlling the sort order, and whether to order is ascending (upward pointing) or descending 

(downward pointing).   Most sorting is done in alphabetic order (currently English alphabet only).   

However, when you sort by the dates columns, Clooz will now attempt to interpret the dates entered 

by the user to place the rows in correct chronological order.  Unrecognized dates will sort ahead of 

dates it can interpret. 

 You can change the sort order for the grid by just clicking on the column header you want to sort 

by.  To reverse the order, click a second time on the same header.  If you want to sort by multiple 

columns, such as by Surname and then by Given Name, click on the column header you want to be 

the primary sort.   Then hold down the SHIFT-key and click on the other columns you desire as 

secondary sorting, in order of decreasing precedence.   So in the case of Surname and Given Name, 

click on the Surname header, then hold down the Shift-key and click on the Given Name header. 

 

Figure 19 - Grid Column Positioning 

You can also change the position order of each of the columns by clicking and grabbing a header and 

dragging it to a new position (indicated by red arrows between the next pair of columns).   To 

remove a column, just drag it off the top of the screen.   However, if you do that, it can only be 

restored by resetting all of the grid layouts using the reset button in the Options window, which 

would return all grid settings to their default values. 

If you want to edit an item in any of the grids, you simply double click on that item and it will open 

for editing.  If you want to add a new item, select Add Person or another choice from the explorer 

bar.  The context menu (right-click) provides access to some additional commands.   In each grid, 

Edit Item will open the item selected for editing the same as if you had double clicked it.   
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Figure 20 - Main People Grid Context Menu 

 

The Edit Alt ID(s) command allows users to enter a single Alternate ID for one or more people.   

This could be useful for those users who use the Alternate ID field for designating family groups. 

In the case of the grid for People, there are menu items for Merge People and Clone a Person.   

Merge People will only be enabled when more than one person has been selected.   You can select 

multiple people by holding down the CTRL-key while clicking on additional people to select.   

Holding down the SHIFT-key will select all people between the one you click and the first person 

you clicked.   Clicking on Merge People will open a form for you to select the name to be given the 

new (combined) person and to validate the operation.   Likewise, Clone a Person is only enabled if 

one person has been selected, and duplicates all data associated with the person selected to create a 

new person, whose details are then presented to you for further editing.   Merging and cloning will 

be discussed in more detail in a later section. 

Clooz version 3.3 added the capability to export people, sources, repositories, and all of the various 

types of documents to Legacy.   The command to initiate this feature appears in this context menu 

whenever a Legacy Family Tree database has been designated as the Primary external file (External 

File Links view), as well as commands to show the IDs used in the external database such as Legacy. 

Finally, all grids will contain options to display the Group-By box and the Search tool bar.  A check 

to the left of the item signifies they are displayed.   Click the item to toggle the display on or off to 

suit your own desires.   Note that the Search tool bar will be restored to view each time Clooz is 

restarted, whereas the Group-By box’s visibility will be preserved with the rest of the grid column 

settings. 

 

Group-By Box 

When you’re in the main grid, you can grab a column header and drag it to the area above the 

columns that says “Drag a column header here to group by that column.”   
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Figure 21 - Group-by Box 

 

So, you can drag Surname into that “gray area” and your list will be grouped by surname.  Grouping 

is similar to sorting, with the added feature of being able to collapse all of the rows with the same 

value into one by pressing the small button with a minus sign, or expand back out with a plus sign.  

For example, this could prove to be useful when working with censuses, and grouping by year.   The 

normal column sorting is still applied, between the data in each grouping.  Dragging more than one 

column heading into the gray area to get a primary and secondary sort is possible but not all that 

helpful, usually. 

 

 

Figure 22 - Census Grid Grouped by Year 

 

To return the display to ungrouped, just drag the header box from the Group-by box back down to its 

normal position with the other column headers. 
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Composite View 

Beginning with Clooz version 3.2, the Composite View was added to the main display area.   The 

Composite View gets its name by bringing together all of the records that are linked to each other 

into a single display.   These records are then displayed in a tree-like structure for easy viewing. 

 

Figure 23 - Composite View 

 

When the Composite View is first displayed, it will list all of the same records as displayed in the 

Grid View, according to the particular Explorer Bar button which was selected.   The editing 

functions in the context (right-click) menu and the Find/Filter functions work the same in the 

Composite View as they do in the Grid View.  When a person is selected from a level below a 

document (document is the next higher level in the tree structure), you have the option of either 

editing the person, or the document detail for that person. 

If a record is linked to other record types, an expansion button is displayed on the left side of the 

row.  Clicking this expansion button (plus sign) will cause the linked records to be displayed below 

the record initially selected.   Double clicking a row also expands the data.   After a row has been 

expanded, the button on the left side will now show a minus sign.   Clicking it will cause the linked 

rows to be collapsed, and only the top level row remains in view. 

If starting from a list of People, expanding a person results in all the documents, images, buildings, 

and research log items appearing that person is linked to.   Clicking on one of those documents will 

expand to show all the people and businesses linked to that document.    You can continue to dig 

deeper down into the tree structure until 5 levels are displayed (the maximum Clooz allows to be 

displayed at one time).   
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The full set of possible record combinations appearing in the expanded groups is shown in the 

following table: 

Top Level Record Type 

(As selected in the Explorer Bar) 
Record Types Appearing in Expanded Lists 

People Documents, Buildings, Images, Research Log items 

Businesses Documents, Buildings, Images, Research Log items 

Buildings People or Businesses 

Censuses and other Documents People or Businesses 

Images People or Businesses 

Sources Documents, Buildings, Images, Research Log items 

Repositories Sources or Research Log items 

Research Log items People or Businesses 

Relationships between Record Types 

 

In some cases, you will be seeing a mix of record types appearing within the same expanded list of 

records (as listed in the table above).   In order to make it easier to identify the type of record each 

one is, Clooz inserts a (Map), (Photo), or (Research) designator in the second column for all image 

and Research Log items. 

 

 

Figure 24 - Record Type Designators in Composite View 
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The sort order for how data records are displayed in Composite Views is controlled by clicking on 

one of the Composite View’s column headers.   Only one column can be selected for sorting at a 

time, and this ordering only will apply to the top level record types.   Appropriate complex sorting is 

preset for each column.   For instance, for the Surname, Given Name column, the sort order is 

defined as being primarily by Surname, and then by Given Name, and then by birth year.   Locations 

are sorted by Country, State/Province, County, and City.    

The column headers in the Composite View will list the format for the contents of each top level row 

and the first set of expanded records below the top level row (in parentheses on the second row of 

descriptions appearing in the headers). 

 

 

Figure 25 - Composite View Header Example 

 

Search Tool Bar 

The Search tool bar is new to Clooz in version 3, and provides a fast way for you to locate a data 

record, especially if you have been using Clooz for a while and have accumulated lots of data.   The 

Search tool bar sits just above the main grid and Group-by box.   Its use applies only to the grid 

displayed at the time.    The Search tool bar has several components. 

 

Figure 26 - Search Tool Bar Components 

The first component is a drop down list of columns which can be searched.  In most cases, these are 

single columns.   However, with the people grid, a combination of Surname and Given Name is 

supported, as well as Other Surname and Given Name.    

The condition component is next, and is another drop down list.   There are three choices, Starts 

With, Contains, and Equals.   A search will find the first row where the value in the designated 

column either begins with the text in the criteria box, contains the text in the criteria box somewhere 

within it, or exactly equals the text in the criteria box.   The matches are not case sensitive, so don’t 

be concerned about capitalization.   You execute the search by pressing one of the action buttons. 

The Find button will locate the first matching row.   The Filter button will change the entire grid to 

only display those rows meeting your criteria.   The Clear button will return a filtered display to the 

full grid display.   The Clear button is only enabled when the grid is filtered. 
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A few tips and shortcuts:   

When searching for names in the Other Surnames column, it is best to use Contains as the condition, 

since the field could contain multiple names.   Using Starts With in that case would only evaluate the 

first or possibly several names for that person. 

When you select the option for multiple columns (as in Surname, Given Name), the text entered as 

criteria must be in that format.  If you do not enter a comma, the search will revert back to a single 

column search using the first of the multiple columns (in this case, Surname).   Thus, you can leave 

the column designation as the multiple case, but only enter the comma and Given Name when you 

really want to.  When you do enter values for multiple columns, the condition is applied to each 

column separately.   Thus if you select Surname, Given Name with the condition Starts With, and 

enter “th, r” as the criteria, you will Find the first row with a person whose surname begins with 

“Th” and a given name that begins with “R”.    

When entering the criteria text, pressing ENTER will execute the Find function. 

On the right side of the Find and Filter buttons, there is a drop down triangle section.   If you click 

on this small section of the button, the drop down list will appear showing the options of Simple and 

Advanced.   Simple is the behavior described above.   Advanced will cause a new form to appear 

which allows more elaborate combinations of data to be located. 

The advanced search window lets 

you formulate any combination of 

fields to be tested, and you can 

designate whether all of the 

columns you select (using the 

checkbox) must be met, or at least 

one of them.   A Find or Filter 

button will appear to execute the 

search, depending on which tool 

bar button you selected for the 

advanced search. 

 

 

Figure 27 - Advanced Search Window 
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Clooz Databases 

Once you install and open Clooz, you create a database. Don’t know what a database is in the first 

place? You’ll find out here, as well as how to create and change or select databases. 

What is a database? 
A database program, like Clooz, lets you store a large amount of information, quickly find certain 

data, and analyze and print everything you’ve entered.  Think of a database this way: imagine you’ve 

got a large file cabinet of your family history research.  Some of you won’t have to stretch your 

imagination too far.  One drawer is full of census records, another is overflowing with copies from 

city directories and other census substitutes, a third drawer is packed with vital records and other 

documents, and the fourth file cabinet drawer contains all the family photos.  A database is like your 

file cabinet full of papers.  But it can manage the data much better electronically on your computer. 

 

Selecting a database 
When Clooz opens for the first time, you will be asked to enter your User Name. Once you do that, 

you’ll be presented with a screen to choose to create a new database, or open an existing database 

(perhaps from an older version of Clooz).You can actually have multiple databases. You might start 

one for all your research with known ancestors and perhaps start another one for possible ancestors.  

You can now merge two Clooz databases together. 

 

Figure 28 - Opening Selection Action Window 
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To create a new database: 

1. Select Open a new (blank) Clooz database from the action screen (shown on the previous 

page).  (You could also go to the File Menu and select New Database) 

2. Click OK. 

3. Once you have created your database, you will be taken to the main screen in Clooz, with the 

Clooz Explorer Bar on the left side of the screen and the People grid on the right side.   You 

are off and running. 

To upgrade a database from a previous version: 

Upgrading from version 1.x of Clooz: 

Please read the appendix to this manual on Converting from Earlier Clooz Databases first. 

1. Select Open an existing Clooz database from the action screen (shown on the previous page), 

and click OK, or select Open Database from the File Menu. 

2. A Windows dialog form will appear to select the file.   Be sure select the .mdb extension for 

listing files from the drop down box in the lower right corner of the form. 

 

Figure 29 - Selecting the Proper Filename Extension 

3. Locate the Clooz database file you want to upgrade. Select it, and then click OK. 

4. You will then be asked if you want to upgrade your database.   Select Yes. 

 

Figure 30 - Request to Upgrade Database 
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5. A window with a progress bar will appear as the upgrade takes place.   If it is successfully 

completed, the following message will appear offering to display the upgrade log. 

 

Figure 31 -1.x Database Upgrade Completed 

 

6. You are now ready to use the database in version 3 

7. If an error had occurred, a similar window would have appeared as above but stating the 

upgrade completed with errors, or with warnings.   Warnings are usually associated with 

missing digital files, and can be fixed in version 3.   Be sure to copy the warnings from the 

log for reference on which images to fix.    Errors are more serious.   You should contact 

Clooz support to resolve the issue before using a faulty database. 

Upgrading from version 2.x of Clooz: 

Before beginning, be sure you have both your .cdb and .fdb files for the database. 

1. Select Open an existing Clooz database from the action screen (shown on the previous page), 

and click OK, or select Open Database from the File Menu. 

2. A Windows dialog form will appear to select the file.   Locate the Clooz database file you 

want to upgrade. Select it, and then click OK. 

3. You will then be asked if you want to upgrade your database.   Select Yes. 

 

Figure 32 - 2.x Database Upgrade Request 
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4. A window with a progress bar will appear as the upgrade takes place.   If it is successfully 

completed, the following message will appear offering to display the upgrade log. 

 

Figure 33 - Database Upgrade Completed Message 

5. You are now ready to use the database in version 3. 

If an error had occurred, a similar window would have appeared as above but stating the upgrade 

completed with errors, or with warnings.   Warnings are usually associated with missing digital files, 

and can be fixed in version 3.   Be sure to copy the warnings from the log for reference on which 

images to fix.    Errors are more serious.   You should contact Clooz support to resolve the issue 

before using a faulty database.   Clooz will automatically return a database that fails to upgrade to its 

original state.   Only successful upgrades of version 2.x files can be used in version 3. 

Change databases 
During data entry, you can change to a different database from the File menu. 

1. Select File from the menu bar. 

2. Select Open Database. 

3. From the file selection window, find your database and double click on it and it will open for 

you. You may need to change folders to the folder where you have stored your other 

database. 

4. Another way to change databases is to look in the list on the File menu above Exit. The last 

four databases that you have opened are listed there for your convenience. Simply select one 

of them and your database will open. 

Close a database 
1. Select File from the menu bar. 

2. Select Close Database from the File menu. 

3. The action screen shown previously will open on your screen and you’ll be able to choose 

another action. 
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Merging Clooz databases 
One of the significant new features for Clooz version 3 is the ability to merge one Clooz database 

into another.    Both of the Clooz databases must already have been upgraded to version 3, or else the 

merge operation will reject your request. 

To perform a merge: 

1. In Clooz, open the Clooz database which you want to hold the combined set of data.   

2. Click on the External File Links button in the Explorer Bar, and select: Merge data from 

another Clooz Database, or in the File Menu, hold the cursor over the Import/Merge 

Databases line and a list of options will appear to the right.   Select Clooz Database. 

3. A file selection window will appear for you to select an existing Clooz database to open.   

Select the file, and click Open. 

4. The new Data Transfer Manager window will now appear. 

 

 

Figure 34 - Data Transfer Manager Ready for Merge 

 

5. The right side is our destination database, which happens to be empty in this example.   The 

source for merged data is on the left.  All elements are selected for transfer.   To initiate the 

merger, click on the Merge Entire Database button in the center of the window.  
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Figure 35 - Merge Verification Message 

6. A message verifying your request is displayed.   Click Yes to proceed. 

7. Progress bars will appear at the top of the window to show progress.   Large databases can 

take a number of minutes to complete. 

8. Once the merge operation completes, a message will appear stating the merge operation is 

done, and gives you the opportunity to review the log file.    

9. Press Close when ready and resume work with your database that now contains all the data 

from the other database as well. 

 

Merging of Clooz databases does not permit selection of individual people or sources like the other 

import operations.   All data from the source file are copied. 
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Database Maintenance 
 

Archiving / Restoring 

You should backup (archive) your databases on a regular basis. You have the ability to do so from 

within Clooz. From the Clooz menu bar under “File,” select Archive Database. A screen titled 

“Enter name of archive file” will open, asking you to enter the name of the file to be archived in 

the File Name window. Type in the name you want to give to this archived database. 

 

If you need to change the location where the backup will be stored, click on the down arrow on the 

Save In window and select a different drive or folder. Once you’ve named the file and changed the 

storage location, click Save to start the archiving process. 

 

Archived files are stored as Zip files. If you need to Restore an archived file, first close any open 

databases, then select Restore Database from the File menu. A window will open asking you to 

select an existing archived file to restore. Look for your archived database, making sure you select 

one with a .zip extension. Clooz will restore your archived database. Since the archived files are 

stored as Zip files, you can also look at the contents of the Zip files using commercially available 

programs such as WinZip or WinRAR. You will still need Clooz to look at the data in your 

databases, but you can use these programs to ensure that your databases have been backed up 

properly. 

 

Compacting 

Compacting your database allows you to tidy up the data, eliminating any deleted references. This 

usually makes the database a little smaller.  This is a housekeeping function that should be 

performed regularly.  In Options on the Edit menu, you are given the choice to automatically 

Compact and Archive your databases.  The default selection is for Compact to happen every time 

you close your database; Archive is not automatically selected for you. To change these options, go 

to Edit/Options on the Clooz Menu bar. 

 

There are numerous reasons why the compacting process could fail.   Do not be alarmed.   Your 

data is safe, since the compaction is on a copy of your original file.  Clooz automatically puts your 

original file back in place if an error occurs.   There are settings in the Option menu to turn off 

reporting of the compacting errors.   The popup message that appears on the screen during 

compaction will indicate at the very end (before disappearing) if the compaction was successful.  It 

is only important that the compaction succeed occasionally to keep your database from becoming 

too large.   Even that is not absolutely critical. 
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Locating Missing Media Files 

When moving your entire Clooz database and attached media files to a new computer or even just 

reorganizing your current computer’s data structure, the links in the Clooz database pointing to the 

various media file locations can become invalid.   That is, the link no longer points to the correct file 

location.   In Clooz version 3.3, a new tool was added to assist users in correcting lost file issues in 

their database.   The Media Location Tool is located in the File Menu, under the Maintenance group. 

 

 

Figure 36  - Media Location Tool 

 

The display will show all the folder locations Clooz has record of where the files are.   When a file is 

missing, a small red icon appears by the name.   In some cases, even the name of the file is missing, 

as shown in the Figure above.   More information can be displayed about any of the files by selecting 

the file, and then pressing the Media Info button (or similar command in the context (right-click) 

menu).  A form then appears to give you more clues as to what the file might be. 
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Figure 37  - More Information Form 

 

The panel on the left side of the Media Location Tool form has some optional control features, such 

as whether you wish to see all the media references in the Clooz database, or only those that are 

currently missing.    

The Locate File, Media Info, and Remove Media buttons that appear on the Media Location Tool’s 

toolbar will only be enabled when a file is selected (highlighted) in the tree structure, since they each 

only apply to specific files.   You can use the Locate File button to set the correct location of a single 

media item.   Just select the file in the list, and then when the normal Windows Open File dialog 

appears, browse to the desired file and click it.   You can even select a file that has a different name 

than what Clooz had a reference to (helpful when the name of the file has been changed). 

The Remove Media button can be used to eliminate the reference in Clooz to that particular file 

(whether it is currently missing or not).   If the file is not missing, the file itself is not deleted.  Only 

the reference in Clooz to the file is deleted.  After clicking this button, the entire list will refresh, and 

the file will no longer be listed. 

When you want Clooz to assist in relocating files, click the Search for Missing Files button to search 

an entire folder for any of the files missing in the Clooz database, relocating as many of them it can 

match up to files in the folder you designate.  When the search button is first clicked, a form will 

appear to allow you to select the folder you want to search in.   If the optional “Include subfolders 

when searching a folder for missing files” checkbox is checked, any subfolders in the folder you 

selected will be included in the search (then subfolders within those folders, and so forth).  

Therefore, to get the broadest search, select a folder that is fairly high up in your hierarchy of folders 

retaining your media files, and turn this option on.  You would not want to use this feature though if 
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you have a habit of giving different files the same name, and keeping them in different folders.   

Clooz will not recognize the difference between two files if they each have the same name. 

When your database has thousands of media files, and if you chose a folder to search such as My 

Pictures that could have thousands of images in it (whether used in Clooz or not), the search process 

could become quite lengthy as Clooz attempts to match up all the media references.  For that reason, 

a progress bar will appear at the bottom of the form while the search is ongoing.   To abort the 

search, press the Stop Search button.   The search will be stopped, but any matches that occurred 

thus far will be already saved in the database.   So you could perform the same search later to find 

additional matches. 

 

Figure 38  - Missing File Search in Progress 

 

Resetting the List of “Most Recently Used” Files 

In Clooz version 3.3, a tool to reset the contents of the “Most Recently User” files list was 

introduced.  It resides in the Maintenance Group that is part of the File Menu.   Click on the Most 

Recently Used Files Tool, and a form will appear that lists all of the current MRU files.   Check the 

boxes for those you want to retain in the list, and then press the Save Checked Items button. 
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Using Clooz 

Determine your strategy 
Clooz version 3 is designed more than ever before to meet your needs without forcing you to do 

things in a prescribed order.   Use it in a way that feels natural to you.   At the same time, once you 

determine your objectives in using Clooz, it’s a good idea for you to become familiar with the 

program features to allow you to work in the most effective manner.  Let’s examine a few examples 

of how different users would best use Clooz. 

Case Study #1 – Data already in a lineage-linked software database 

Joan is a new Clooz user who has been building her family tree using Family Tree Maker software 

for the last decade.   She has gathered lots of data and has over a few thousand people in her family 

tree database.  Much of the data (including censuses, vital records, immigration records, and church 

records) have been documented in Family Tree Maker as sources, and physical copies of the 

documents have been filed according to document type.  Joan loves to search and find new 

information, more so than filling out computer screens of information, so she also has accumulated a 

pile of copies of documents from her more recent research that has not yet been ‘processed’ into her 

Family Tree Maker database.     

Joan is intrigued by Clooz’s document-based approach, but has serious concerns about retyping all 

of her document records into Clooz.  She wonders how she might use Clooz. 

Here’s how: 

Since Joan already has a substantial amount of research already done, with people in her Family 

Tree Maker database, her first step should be to import those people and sources into Clooz using a 

GEDCOM file (since Clooz only presently supports direct importing from current versions of 

Legacy Family Tree, RootsMagic, and The Master Genealogist). 

Joan decides that many of her ancestral lines have been sufficiently researched, and does not want to 

take the time to detail them further in Clooz at this time.   Maybe someday when she has time, 

because she ultimately does want to use Clooz as the focus of her document repository.   While 

Clooz could easily help her locate files containing physical copies of the documents, she likes the 

idea of a paperless approach where images of her documents are always at her fingertips. 

Dealing with her backlog of processing documents more recently found is Joan’s top priority.  She 

enters these into Clooz, and uses the new feature for letting Clooz create new people for each one 

contained in the document.   Then she can begin to make the decisions on whether these are the same 

people as those in her tree, and merge them together.   Joan’s research techniques had matured over 

the years, and now she knew not to just throw people into her family tree without substantial analysis 

and proof.  Once she considered it proven, she would enter the person in her family tree.  Since 

Legacy Family Tree software is the only software Clooz exports individuals and sources to (version 
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3), she will use copy/paste techniques to transfer information back to Family Tree Maker to keep her 

family tree up to date. 

Finally, Joan knew that some of her ancestral lines were only partially complete.   So she decided to 

enter the document information for those people into Clooz to allow for more thorough reporting and 

analysis, being able to see all of the evidence available to her.   She already knew for sure that the 

people named in the documents were ones in her tree, so she used the traditional Clooz approach of 

linking existing people to the documents she entered.   This saved the step of having to merge people 

records later.   She was amazed to discover, like many Clooz users over the past years have reported, 

that during the process of entering the document information into Clooz, it forced her to pay 

attention to the details contained in the document, and in fact identified additional clues regarding 

her ancestors.   Maybe she wouldn’t put off entering all her documents after all. 

 

Case Study #2 – The Reformed Researcher 

Frank has been gathering family tree information for a few years, and like Joan, uses lineage-linked 

software to create beautiful family tree charts.   He doesn’t have a whole lot of document files, but 

there are two boxes of stuff under the table beside his computer.   He has collected GEDCOM files 

from all over, where ever he could find them, and diligently enters the source of the GEDCOMs in 

his database.   Sources are important you know.   One year, Frank attended a National Genealogical 

Society Family History Conference in a city near his home.   While listening to Joan give a talk on 

using document evidence to prove family relationships, he was just overcome with the realization his 

prize family tree database was, frankly speaking, garbage.  

It was time for Frank to rebuild his family tree with adequate evidence and documentation.  He got a 

tweet from someone called @CloozJoe and heard about Clooz.   The notion of document-based 

analysis of information made perfect sense to him, besides, Clooz imported GEDCOM files. 

Frank decided he would use Clooz as his primary research tool: 

He would start with a clean new Clooz database and dig out those two boxes of stuff under the table 

to see if there was in fact, anything useful.   He did find a few birth records and immigration 

documents from his great grandparents.   So Frank used his new scanner to make digital copies of 

the documents and setup a special folder directory to organize his digital file attachments into one 

general location on his computer.   While looking at the list of files using the Windows Explorer 

program, he was able to simply drag and drop them into Clooz. 

Frank was given a subscription to an online data provider, and after the little green leaf lit up, started 

doing searches for all sorts of documents and information.   He was able to save digital copies of 

documents on his computer, and drag them into Clooz.   He could even highlight the source citation 

information on the data provider’s web page and drag it into Clooz.   It didn’t automatically get 

dissected and reformatted (wouldn’t that be nice), but at least the information was captured.  He 

could then easily fill out Clooz’s form for the source by copy/pasting segments from what he had 

captured.   Less typing is good he thought. 
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Using the documents Frank was entering, he entered the details related to each person listed in the 

document and let Clooz generate a new person record and link it to the document.  After entering all 

the documents he could find that might relate to the family he was interested in, he printed himself a 

few reports and sat back to mull over what it all meant.   Finally he was able to prove to himself that 

several of the documents related to the same person, so he merged those people together, and added 

a remark to the combined set of records detailing his logic.  Joan would be proud he thought.   He 

was now on the way to building a well-founded family tree. 

 

Case Study #3 – The Professional 

Elizabeth was a certified genealogist for many years.   People would come to her with the most 

extremely difficult cases.   One of her problem solving approaches was to do single surname studies 

in discrete geographic locations.   She was proficient at using a spreadsheet program, but sometimes 

it just fell a bit short in terms of fully meeting her needs.   She had an old copy of Clooz, but it was 

not the friendliest program to use.   Then she heard the new version 3 was much easier to navigate, 

with more flexibility to do what you need.   She gave it a try. 

Elizabeth decided to integrate Clooz into her work in several ways: 

She used Clooz to record census records of a particular surname she was researching in a region of 

Pennsylvania.   She captured digital images and attached them to each of the documents she 

recorded.   Elizabeth found that treating census enumeration districts as ‘documents’ in Clooz 

seemed to work the best for her.   Clooz version 3 allowed her to attach multiple digital files (one for 

each page) to the same document.  The whole surname study was put in a database of its own.   She 

could always merge the Clooz databases later if there was reason to look at all the data together.    

Elizabeth found that the reports Clooz generated could be exported into a variety of file types.  The 

Adobe pdf files were good, and other formats would allow further reformatting using her suite of 

office applications.   She could include the generated reports in the overall report to her customer. 

Since Elizabeth had all sorts of projects, she ended up with various external lineage-linked 

databases.   She ended up importing individual records from many of the databases.   Clooz could 

identify which file a person’s record came from and what their identification number was in the 

other database.   This allowed her to be able to reference and locate people accurately between her 

various digital tools.   She was convinced that Clooz belonged in her toolkit. 

 

Case Study #4 – You! 

How can Clooz meet your needs? 
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Planning your research 
Planning your research and setting specific objectives is an important element of a well-structured 

family history research effort.  Clooz provides a Research Log to assist you in this particular task. 

 

Figure 39 - Clooz Research Log Form 

Research Log 

What is a research log? A research log helps you keep track of all of the research that you are 

conducting, whether you have positive or negative results.  It is important to keep track of the 

research you conduct so you don’t repeat the same research multiple times.  With so little time 

available for research, who needs to look for the same thing twice? 

In Clooz, the research log has been taken one step further.  If you use a laptop while you’re 

researching, you can use the research log form to keep track of everything that you look at.  You can 

record the results of your research right then, so you don’t have to rely on your memory.  If you 

make copies of items you find that pertain to your family, you can then easily convert the research 

logs to Clooz documents (using the appropriate template), with a minimum of additional work.  So, 

keep track of everything you look at, and when you get a chance, enter a Personal File # into the 
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research log template if you have physical files and convert the research log to an appropriate Clooz 

document. 

To enter information into a Research Log, take the following steps: 

1. Select Research Log from the Clooz explorer bar. 

2. Select Add Research Log from the Clooz explorer bar and a blank Research Log screen will 

appear. 

3. Enter a Log ID number. This number can be anything you need it to be to keep track of 

research log entries. 

This number is not the same as Personal File #, which can be added later on the form.  If you 

want to enter research logs in sequential order, you can look at the grid on the right side of 

the screen when you select the Research Log category on the explorer bar.  There you’ll be 

able to see all assigned Log ID numbers. 

4. If you’re looking at a Source that has not yet been entered in Clooz, click on the New Source 

button to add the Source.  You won’t be able to just type a Source Title in the Source Title 

window; you’ll need to select New Source to enter the Source for the first time. When you 

click on the New Source button, you’ll be asked to choose what type of source you’re 

entering.  For some types of documents, such as vital records, the best choice may be 

Certificate; for other records, the best choice might be Register. If you’re unsure of the 

source type, check the Source section in this manual for suggestions. Once you select a 

source type, the appropriate Source screen will open. When you complete entering the 

Source information, click on the Exit button and you’ll be taken back to the research log 

screen. The title of your source will appear in the Source Title window.  Sources already 

selected on this form can be edited in the Source editing form by right-clicking on the source 

title and selecting Edit. 

5. Enter your Search Objective. This can be something like the entry above, finding Eugene 

Pahnke’s death record, or writing for a birth certificate.  Be specific.  The search objective 

shouldn’t be too broad that you need to search multiple sources for the item, because you can 

only link one source to a research log. This may help you focus on exactly what it is you’re 

looking for. 

6. Enter the Time Period covered by this search objective. 

7. Enter the Results of your research. This is a crucial part of the research log.  Without the 

results, there’s no point in keeping track of your research.  Be sure to fill this section out.  It 

may save you from doing duplicate research in the future. 

8. Personal File #. This field can be skipped if you didn’t find what you were looking for in the 

source.  You can also skip it for now if you did find what you were looking for, but want to 

enter the document into Clooz at a later time.  The field is designed for you to record the 

Personal File # that you want to assign to the document that you have found.  If you enter the 
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research log information now and come back later to enter the document, you can fill in this 

field at that point.  However, it is now an optional field in Clooz version 3. 

9. The File Path/URL and associated description is there for you to record the digital location of 

the record you’re entering, if there is a digital copy.  For instance, if you have saved a copy 

of a document to your hard drive, then you would click on the Add File button to the right of 

the Digital File window. If the copy of the document you have is in graphic format (i.e. saved 

with an extension such as .JPG or .TIF), then it will be treated as a Picture.  If you have a text 

transcription of the document (i.e. saved with a .TXT, .RTF, or .DOC or other extension), 

Clooz will treat it as a Document.   Finally, if a URL for an Internet web site is entered in the 

File Path/URL cell directly, or dragged from an Internet browser program, it is recognized as 

a Website.   The View button will have the system attempt to display the file using whatever 

software you have setup Windows to use as your default viewer for that file type.   The 

Remove button will eliminate the link to the selected File Path/URL (the actual digital file is 

not deleted.) 

10. In the lower left area of the form is a box with radio buttons for People and Business.   This 

allows you to select whether the action of the Link and New buttons is to apply to a person or 

a business. 

11. The Link and New buttons give you two options for linking a person (or business) to the log 

record.    

You can click the New button to have a new person or business generated by Clooz 

automatically based on the surname and given name entered on the research log details form 

that will appear.     

–OR- 

To add an existing person to your research log, click the Link button.  The people (or 

business) selection screen will appear. Select a person from the list by clicking the check box 

in the far left column and click on the Link Selected button to link the selections to the 

underlying document. Alternately, you can double click on the selection within the list to 

perform the same operation.  You can only link a person or business to a specific research log 

record once. 

You can find a name in your Clooz People list by scrolling to it or searching for it with the 

Find button in the Search tool bar.   This Search tool bar functions the same with the Link list 

as it does on the main People grid.   

The research log input form and all other input forms in Clooz contain a Link button to add 

people (or businesses) to your records. You should link all people that you were either 

looking for or found as a result of this research.     

Click the Add Person button on the Link list Window to add a new person. 
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Figure 40 - Link List Window 

   

12. For each person now linked to your Research Log record (or any other Clooz record form), 

double click on that person’s name to enter their detailed information exactly. 

13. Click on the Print Report button to generate a summary report of the Research Log record.   

A preview of the report will appear, with the further option to actually print it. 

14. Click on the Delete Log Item button to delete the entire Research Log record, and all of the 

links associating people or businesses with it.   Any details of the people or businesses 

entered under this Research Log record will be deleted; however, the people or businesses 

listed will not themselves be deleted.   Use this carefully. 

15. If you find an item associated with this Research Log entry, enter the Results and optionally 

add a Personal File # to that field, and then click on the Transfer to Clooz Template button. 

The following screen will pop up, allowing you to choose the type of Clooz document 

template appropriate for that document. 
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Figure 41 - Template Selection Window 

 

16. Select the appropriate template and then click on Create Template. The template will open, 

with your Personal File #, source information, and linked people already there for you.  You 

will need to complete the rest of the fields in the template, as well as filling in the details for 

each person linked. 
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People and Businesses 

Nearly everything in Clooz is focused on documents in some way or another.  As family history 

researchers, what brings us to use Clooz is ultimately finding more information about people, as well 

as businesses they may have been associated with.   But from the Clooz perspective the main use for 

having people and businesses in the database as separate entities is to link them to documents, and 

the information contained in those documents.  This is an important concept in understanding the 

Clooz process. 

The following sections will review how you add, edit, and delete your people and business records, 

as well as how to connect the people in Clooz with people in your lineage-linked software program. 

 

Adding People 
There are two major data entry components to Clooz, one being all of the document records, and the 

other is the people linked to each of the records.   You can record a person’s information either 

before linking them to a document record, or at the same time as linking them (new for version 3). 

People can be added in one of three ways: 

Let Clooz add them automatically after you enter the document details related to that person. 

Manually add them as a new person (separate from any document related activity). 

Import them from another database or GEDCOM file. 

 

Add people automatically from document details 

In all of the Clooz document templates, in the lower left section of the screen there are controls for 

linking people and businesses to the document record.   Within this group of controls, when the New 

button is clicked, Clooz will display the details form related to that type of document.   This always 

includes the name of the person (or business when applicable).   When the details form is saved, 

Clooz will create a new person record using the name provided on that form.   The form will not exit 

unless a name is entered (unless the whole operation is cancelled). Other data fields that form a  
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Figure 42 - Link Group Box 

person’s record in the database include birth, marriage, and death dates, can be added later by double 

clicking on the person in the main people grid (or by right-clicking on the person and selecting Edit) 

This is the preferred way for adding people when you are not already sure the person in the 

document is the same as others in your database with the same name.   In those cases, it is better to 

merge people’s records later after you have studied the issue.  It would also be the preferred method 

for adding people you know are not already in your database.    

 

Manually adding new people 

If you are going to add people one at a time, click on People on the explorer bar.  This will open the 

People section of the explorer bar where you can choose the Add Person selection there.  You will 

also notice that once you have people in Clooz, the bulk of your screen will be filled with a grid 

containing a list of the people in your database, including their ID, Alternate ID, Surname, Given 

Name, Other Surnames, Birth/Baptism date, Marriage date, and Death/Burial date. 

To add a new person this way: 

1. Click People on the explorer bar on the left. 

2. Click on Add Person. The New Person screen opens, where you can add information about 

this person.  Complete as many fields as possible and then select to either add another person 

or to exit the screen.  If you decide you don’t want to add this person, you can click on the 

Cancel button, which takes you back to the People grid, or you can use the Esc key on your 

keyboard.  Don’t worry about the other tabs on the New Person form yet. You will link this 

person to Censuses, Census Substitutes, Documents, Images, Buildings, and the Research 

Log later. 

3. The Person ID field is an auto numbered field, meaning that Clooz automatically fills it in for 

you.  It cannot be changed in Clooz. 

4. Surname. Enter the birth name or the name you know him or her by. For example, enter 

females with their maiden names.  If you don’t know the maiden name of a female, you can 

leave this field blank.   Married names are now entered elsewhere. 

5. Given Name, Prefix Title, Suffix Title.   These parts of the person’s name are entered in their 

respective fields. 
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6. Married Names.  The married surname of females, if known, should be entered into the 

Married Names field.   On the People grid, it will show up in the Other Surnames column, 

along with any other surname spellings used in any of the documents they are linked to.   

 

Figure 43 - Person Window 

 

7. The Alternate ID is a field where you can enter your own number, words, or letters to further 

identify a person.  For example, if a person in your files or in another genealogy program was 

given a different ID than that assigned by Clooz, you might enter that number as an Alternate 

ID number. You can also use the Alternate ID field to give yourself additional clues about 

the new person. You could enter a married name for a woman, or an occupation for someone 

to help you separate that person from someone else with a similar name. 

8. Birth/baptism, marriage, and death/burial dates. Enter at least one of these, if known, to help 

identify an individual from others with the same name. Fill in a completely spelled out date if 

you wish, preferably in the day-month- year format, such as 10 September 1853. The fields 

allow for 50 characters. 

9. Remarks. This field allows you to enter any additional information about the person that you 

feel is pertinent. 

10. When you’re through with data entry of people, click on the exit button to close the form. 

 To edit a person’s data: 
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If you need to edit a person’s entry, just double click on that person’s name in your list of people. 

You will be taken back into that individual’s form.   You can also select Edit Item in the context 

menu (right-click) for that person. 

To delete a person: 

If you need to delete a person, find that person’s name in the list of people and double click on it. 

The individual’s form will open. Click on the Delete button on the form to delete the person’s entry. 

You will be asked to confirm the deletion. 

 

Import new people 

Clooz 3 provides a whole new method for importing people (as well as sources and repositories) 

from other databases and GEDCOM files.  Events cannot be imported, since Clooz is document-

based.  Clooz can now import data from the following sources: 

Legacy Family Tree databases (version 6+) 

RootsMagic databases (version 5+) 

The Master Genealogist (version 8+) 

GEDCOM files  

In additional, entire Clooz databases can be merged (discussed earlier). 

GEDCOM stands for GEnealogical Data COMmunications, and is the only “standard” that exists in 

the genealogical community for data exchange between programs.  Not all GEDCOM exports are 

created equally, however, and Clooz attempts to adjust for known non-standard formats. 

During the import setup process, you can now select a specific set of individuals to import, or all of 

the individuals in a database.  It’s all up to you. 

To open the Data Transfer Manager, go to the File menu and select Import/Merge Databases, and a 

secondary menu will appear for you to select the desired type of file or database to import.  

Alternatively, you can click on the External File Links button in the Explorer Bar, and then select the 

desired type of file or database. 

The first thing to appear will be a file selection window where you need to select the exact file to 

import from.   Then click on OK to continue to the Data Transfer Manager window. 

The Data Transfer Manager will first appear with People selected as the Record Type.   If you want 

to import Sources/Repositories, you need to change the Record Type using the box in the middle of 

the window.  Imports of People and Sources need to be performed separately. 
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With most other database types, the form will appear with both an Import and Export button.   The 

Export button will be discussed later, although it works just like the Import, except copying data in 

the opposite direction.   The external data source will appear on the left side of the window, and your 

Clooz list of people will appear on the right. 

 

Figure 44 - Data Transfer Manager Window 
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Figure 45 - Data Transfer Manager context menu 

Your first task is to select the individuals to be imported.  This can be accomplished by clicking on 

the small check boxes to the left of the RIN or ID number.  The square buttons just above the list can 

be used to select all of the people at once, or clear all selections.  You can also select groups of 

people by highlighting the lines (click on one name and then hold the SHIFT-key down while 

clicking another will select everyone in between the two), the right-click to bring up the context 

menu and click on Mark for output.   All of the highlighted row will then show check marks.    

When you are satisfied you have selected the people you want to import, click on the Import button.  

A message box will appear for you to confirm the action. 

 

Figure 46 - Import Verification Message 

 

Once the import is complete, the imported people will appear in the Clooz list on the right side, and 

reflect their RIN/ID from the other database.   A small icon appears to identify which type of 

database the RIN/ID came from. 
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Figure 47 - Import Results 

Adding new businesses 
 

To add a new business, click on Businesses on the explorer bar. This will open the Business section 

of the explorer bar where you can choose the Add Business selection there. You will also notice that 

once you have businesses in Clooz, the bulk of your screen will be filled with a grid containing a list 

of the businesses in your database, including their ID, Alternate ID, Business/Organization Name, 

Owner Name, Date Opened, and Date Closed. 

To add a new business: 

1. Click Businesses on the explorer bar on the left. 

2. Click on Add Business. The New Business screen opens, where you can add information 

about this business. 
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Figure 48 - Business Details Window 

 

3. Complete as many fields as possible and then select to either add another business or to exit 

the screen.  Use the Ok button (with the door on it) to exit.  If you decide you don’t want to 

add this business, you can click on the Cancel button to cancel your entry and take you back 

to the Business grid, or you can use the Esc key on your keyboard.  Don’t worry about the 

other tabs on the New Business form yet.  You will link this business to Censuses, Census 

Substitutes, Documents, Images, Buildings, and the Research Log later. 

4. The Business ID field is an auto number field, meaning that Clooz automatically fills it in for 

you. It cannot be changed in Clooz. 

5. The Alternate ID is a field where you can enter your own number, words, or letters to further 

identify a business. This field is yours to use as you need to. 

6. Owner Name. Enter the name of the primary owner of the business. 

7. Business/Organization Name. Enter the name of the business or organization. 

8. Date Opened and Date Closed. Enter what you know about the business’ opening and closing 

dates. Fill in a completely spelled out date if you wish, preferably in the day-month- year 

format, such as 10 September 1853. The fields allow for 50 characters. 

9. Remarks. This field allows you to enter any additional information about the business that 

you feel is pertinent. 
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When you’re through with data entry of businesses, click on the exit button to close the form. 

 

Edit businesses 

If you need to edit a business’ entry, just double click on that business’ name in your list of 

businesses. You will be taken back into that business’ form.   You can also open the business form 

from the Business grid’s context menu (right-click). 

 

Delete businesses 

If you need to delete a business, find that business’ name in the list of businesses and double click on 

it. The business’ form will open. Click on the Delete button on the form to delete the business’ entry. 

You will be asked to confirm the deletion. 

 

 

Linking People in Clooz to other Programs 
 

Clooz 3 implemented a number of new features for maintaining the original identification number 

(RIN in Legacy) used with persons appearing in other databases.   However, note that not all 

lineage-linked software programs make these numbers visible to users; some versions of Family 

Tree Maker for instance, hide these numbers.   You may need to explore the program’s option 

settings to see how to make the record numbers visible.  The programs Clooz does acquire data from 

directly all do use such numbering.   So this may or may not be useful to you depending on the other 

software you use. 

There are three places in Clooz where you can see what the lineage-linked software program’s 

database identification number was for a particular person in your Clooz data: 

In the Data Transfer Manager when opened for the file you imported the data from, in the External 

Links tab of the People detail window, and in the Document Export function (described later in this 

document). 

In both case, the numbers appear with icons representing the particular program the ID is referring.   

This is to avoid confusing them with Clooz’s internal IDs.   The Data Transfer Manager also has 

some special features related to these numbers.   When the list is displayed, the numbers are verified 

against the numbers in the other program’s database.   If the person was deleted from the other 

program, the number will disappear at this point in Clooz.   If the other program’s numbers were 

reordered in some way, Clooz will attempt to use some hidden identification values the other 

programs usually have to update itself to the new numbers shown to users. 
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Finally, the Data Transfer Manager allows you to edit the numbers on the Clooz side (right side) so 

that you can manually record what ID value should be tracked when the person in Clooz was not 

originally imported from that other database.   A cell will go into edit mode when you click on it. 

 

Figure 49 - Edit of RIN in Data Transfer Manager 

 

The identification number for our person of interest, Charles Salomon Chapelle, has been 

highlighted in yellow in Figure 49 for clarity.   This is the number we want to track, so you would 

enter it into the RIN field on the Clooz side.   Once you press ENTER or click on another row, the 

linkage is established (note the icon now appears in Figure 50, below). 

 

Figure 50 - RIN Edit Completed 

Once you enter this number, Clooz will maintain it with the same consistency checks each time you 

open the Data Transfer Manager window. 

An easy way to open the Data Transfer Manager with files you have already imported data from is to 

click the External File Link button on the Explorer Bar.   When you do, the main grid will show a 

list of the files you have imported from.   Double click a particular file to open it in the Data Transfer 

Manager.  Note that Clooz tells you how many people you have linked from this file. 



 

54    People and Businesses Clooz 3 User Manual 

 

Figure 51 - External File Links Grid 

As mentioned earlier, the other way you can view identification numbers related to other databases is 

in the File Links tab of the People details window. 

 

Figure 52 - File Links tab in People Details 

Charles Salomon Chappelle’s file links now show that he is RIN 1795 in our Legacy file, as we had 

entered.   Click the Unlink ID Record button at the bottom of the window to delete links. 

 

 

Transferring Links from one External Program to Another 

Over time, it may become necessary to switch from one genealogy program to another, or to move a 

portion of your family tree to a new file even using the same external program.   For example, The 
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Master Genealogist users may be switching to RootsMagic or Legacy Family Tree since 

development support for The Master Genealogist has been terminated.   Clooz users who have 

invested a substantial amount of time in building their Clooz database and linking it to the people 

and sources in The Master Genealogist database would want to apply the same links to their new 

family tree database.   To support this, Clooz has a special utility for synchronizing the links it has 

with two or more external databases.  This is a very powerful capability.   Be sure to meticulously 

observe the cautions posted in this section, and in the program windows associated with the 

feature. 

Users who decide to perform this synchronization must understand it is an advanced capability, 

requiring user thought and preparation, as well as a thorough understanding of the system of Record 

Identification Numbers in use for EACH program.  It is extremely important to recognize that the 

proper time to use this tool is only when there are matching ID values in the two external files. 

In order to be able to duplicate the same links between Clooz and an external file, you must create 

the new family tree file in such a way as to preserve the Record Identification Numbers (RINs), or 

one of several other identification numbers (a user reference number, Ancestral File Number, or 

FamilySearch ID).     Not every external file supports all of these options.  For example, when 

transferring from The Master Genealogist or GEDCOM files, the only option for synchronization is 

using the RINs.   Both Legacy and RootsMagic support the full set.   

VERY IMPORTANT!  Remember that your Clooz file is the central player in this synchronization 

process.   In the instructions that follow, the external file you previously linked with Clooz is 

referred to as the Reference File.   The external file that you wish to apply these same links to is 

referred to as the Target File.  Always backup your Clooz database before proceeding. 

The synchronization (or transfer) process to a new database begins with your Clooz file.  Click on 

the External File Links button in the Explorer Bar (left side of screen) to display the current list of 

external files you have previously linked to Clooz.  Right click on the file you want to use as the 

reference file (Clooz has links to this file).   The familiar pop-up menu will display, but the new 

Transfer Synchronization menu item will appear as the last line item, as shown in the following 

figure.  Click on the Transfer Synchronization option. 

 

 

Figure 53  - External Files Context Menu 
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The Synchronization Transfer Tool form will now appear allowing you to setup the transfer 

operation. 

 

Figure 54  - Synchronization Transfer Tool 

 

The next step is to select the identification fields to be used in matching records in the reference file 

to those in the target file.  Be sure to double check your designations of the Reference and 

Target files.  When there are multiple options, open up the drop down box to select the appropriate 

field.    In the preceding figure, the Reference File options are grayed out, since the RIN field is the 

only possible selection for a The Master Genealogist database.  However, that does not necessarily 

mean the target file must also be the RIN field.   The field selection for the target file needs to say 

where the RIN values from the reference file ended up in the target file.     

If a GEDCOM file was exported from The Master Genealogist, with the option set to include the ID 

numbers, and then imported into a new (blank) Legacy file, the RINs will continue to appear as 

RINs.   However, if The Master Genealogist data was directly imported into RootsMagic (GEDCOM 

was not used), the original RINs will now appear as reference numbers in RootsMagic, so the 

User/Reference Number would be the appropriate field to select.   It is beyond the scope of this 

document to thoroughly describe how each of these various programs work.   It is up to you to read 

their documentation on importing and exporting data to gain a firm understanding of how the data 

are handled. 
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Figure 55  - Identification Number Selection 

 

The ability to select any combination of fields to be used in the transfer opens up all sorts of 

possibilities for using this tool beyond the case where you are moving to new family tree software.   

While building your family tree files, if you had entered a User Reference ID for the people in both 

files, you can transfer the links made with Clooz from one of those files to the other.   As described 

earlier, the fields used in both the Reference and target files do not have to be the same type of 

identification.   They only need to contain the same value (such as the User Reference ID in one 

external file actually being RIN values that match the RIN values in another file).   Likewise, both 

the Reference and target databases can be of the same type of external program (transferring the 

links in Clooz from the reference Legacy file to a target Legacy file). 

All of these details can be quite confusing.   Our recommendation is that you first open the two 

external databases at the same time in their respective programs (such as in The Master Genealogist 

and Legacy) to verify the identification numbers you believe should match actually do match. If the 

ID numbers match the wrong people, then the synchronization tool is not applicable to this particular 

situation.    

As previously emphasized, be sure to make a backup of your Clooz database before attempting any 

transfers.   In that way, you can always go back if you selected the wrong fields and start over (after 

restoring Clooz using the backup you made).    The only file affected during one of these transfer 

operations is the Clooz database.   The external files are not modified.   In fact, if this is the first 

time you are linking Clooz to a particular external file, and the result was not as you expected, you 

can simply delete that file from the external file links list and Clooz will then delete all links it has to 

that file. 

The next step is to indicate what type of links you want to transfer.   The options are to transfer the 

links to people, and/or the links to sources (see next Figure).  
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Figure 56  - Apply Options with Transfers 

 

The last preparatory step is to select the target file (the file you are trying to apply the links to).   

Click on the Select File button (see Figure 54) to open a file selection dialog box.  Select the 

appropriate file, and click Open. 

 

 

Figure 57  - Target File Selection 
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The file paths for both the reference and target files should now be displayed at the bottom of the 

Synchronization Transfer Tool. 

 

Figure 58  - File Path Display 

 

Now click on the Perform Transfer button to begin the transfer process. 

If you are attempting to apply a set of links where the identification numbers in the target file do not 

properly match those from the reference file, you will likely see pop-up alerts stating that the name 

of the person in the target file does not match that in the reference file.   Unless you are sure it is in 

fact the same person (with some minor spelling difference), you should Cancel the operation 

(clicking the Cancel button) and attempt to figure out what is not like you expected.  Cancelling, 

however, does not undo any changes already made in the process. 

In the case of linking Clooz sources to those in the target file, a check is made of the source label, 

the source title, and source author (if it is included in the Clooz source).   If these do not match 

exactly, no link will be established from Clooz to that source in the external file.   If there are 

multiple sources in the target file matching the source in Clooz, a warning message will pop up. 

 

Figure 59  - Source Match Warning 
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If this occurs, no link will be established.   You will need to identify the appropriate matches 

manually in the Data Transfer Manager, which appears when all links have been made.  It is 

important to understand that only those Clooz sources that were linked to the reference file will be 

linked to the target file as well. 

Visual clues are displayed in the Data Transfer Manager to show which records are linked.  Note in 

the next image that an icon appears to the right of the check box, indicating that the record is now 

linked in the Clooz database.  Please also remember that synchronization is not based on names, but 

is based on matching RIN numbers.  The name test is only to produce a "validity check” for what 

you are doing to identify cases where different people have the same RIN number in their respective 

files. 

 

 

Figure 60  - Linked People in Data Transfer Manager 

 

In the Data Transfer Manager you can make manual adjustments to the links by editing the RIN 

column on the right side of the form (where the Clooz data is displayed).   The left side shows the 

external file data.   The previous section of this user guide gave additional instructions on how to use 

the Data Transfer Manager. 
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Figure 61  - Linked Sources in Data Transfer Manager 

 

After Closing the Data Transfer Manager (Close button), be sure that the desired file is now the 

Primary external file (appears in bold font).   This is the file the identification numbers displayed on 

the main screen (and while exporting) apply to. 

 

Figure 62  - Changing Primary External File 
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Entering Records 

Now you’re ready to begin attacking those stacks of unfiled records!   

From the Clooz explorer bar, select the record type you want to enter. There are several choices: 

buildings; censuses; census substitutes; documents that don’t fit into the first three categories; 

images; and sources. Once you select one of these choices, on the right of your screen you will see a 

list of all entries of that record type in Clooz (once you’ve entered data, of course). To add a new 

record, choose the appropriate selection from the explorer bar. 

General Template Features 
When you start using the various document templates you will notice there are a few sets of data 

entry controls that are the same in all of the templates.   We’ll discuss those here, instead of 

repeating the information when discussing the different document types.  The example shown below 

identifies the various components of document templates. 

 

Figure 63 - Typical Template Components 
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Document Information 

Each document template will have a data entry section at the top of the form for information 

applying to the entire document (versus that applying to a person).   An example would be the 

Enumeration District for censuses.   

Part of the document information section is a drop down control to select the source of the 

document.   Click on the down arrow on the right side of the field, and the list of sources will appear.   

Click on the appropriate source.   If the source you need is not listed, click on the New Source button 

and a form will appear to create a new source record.   There will be more information on that later 

in the Sources section.  If you want to edit the source, right click on the Source Title, and select Edit 

Source, or to clear the selection from this document, select Clear Selection on the right click menu. 

File Path and URL List 

The File Path/URL and associated description is there for you to record the digital location of the 

record you’re entering, if there is a digital copy.  For instance, if you have saved a copy of a 

document to your hard drive, then you would click on the Add File button to the right of the Digital 

File window. If the copy of the document you have is in graphic format (i.e. saved with an extension 

such as .JPG or .TIF), then it will be treated as a Picture.  If you have a text transcription of the 

document (i.e. saved with a .TXT, .RTF, or .DOC or other extension), Clooz will treat it as a 

Document.   Finally, if a URL for an Internet web site is entered in the File Path/URL cell directly, 

or dragged from an Internet browser program, it is recognized as a Website.   The View button will 

have the system attempt to display the file using whatever software you have setup Windows to use 

as your default viewer for that file type.   The Remove button will eliminate the link to the selected 

File Path/URL (the actual digital file is not deleted.) 

 

Figure 64 - File Path List Context Menu 

The context menu for the digital files list can be displayed by right-clicking on the list of files.   You 

can use this menu to paste in text, either to an existing item (if that was what you right-clicked on), 

or as a new entry.   This could be a file copied from Windows Explorer.   There is also an option in 
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the menu for you to create a new entry (blank), which you could fill out manually by typing.   To 

edit any file path or description manually, just click in the text area to activate the editor. 

One picture file can be selected as primary, and will appear on the form in the thumbnail area.  

Either select the file and press the Primary button, or right-click it and select the Select picture as 

primary context menu item. 

Link Grid and Link Controls 

The link grid holds references to the people or businesses that have been linked to the document.   

Double clicking on an entry in the Link Grid will display the details form for it. 

The People and Business (if enabled for the particular document type) radio buttons in the lower left 

section of the screen determine whether the link controls and link grid apply to people or to 

businesses.   Usually you will have it set on People, which is the default. 

The Link and New buttons give you two options for linking a person (or business) to a document. 

You can click the New button to have a new person or business generated by Clooz automatically 

based on the surname and given name entered on the details form that will appear.     

–OR- 

To associate an existing person with the document, click the Link button.  The people (or business) 

selection screen will appear. Select a person from the list by clicking the check box in the far left 

column and click on the Link Selected button to link the selections to the underlying document.  

Alternately, you can double click on a single selection within the list to perform the same operation.  

You can only link a person or business to a specific research log record once.  
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Figure 65 - List for Making Selecting Person to Link 

You can find a name in your Clooz People list by scrolling to it or searching for it by entering your 

search criteria and clicking the Find button in the Search tool bar.   This Search tool bar functions the 

same with the Link list as it does on the main People grid.   

The Link Grid also has a context menu associated with it.   The first three items are just alternatives 

to using the Link or New buttons, or double-clicking an item.   The last item is the only way on the 

document form to unlink a person or business from the document. 

 

Figure 66 - Link Grid Context Menu 
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Common Buttons 

All of the document template forms have buttons for deleting the entire document (including all of 

the links and associated details; but not the actual person or business), for printing a report summary 

of the document contents, and the standard OK (to save and exit) and Cancel (drop any changes 

made on that form) buttons. 

Sometimes in Clooz you can call up one form from another, such as displaying the details for a 

person when double-clicking their entry in the Link Grid.   You need to know that if you click OK 

on the second form, pressing Cancel on the original form will not undo the changes made earlier on 

the second form.   Once you press OK on any form, the data associated with that form is saved. 

Each time a document is saved, Clooz will check to see if a birth or death event can be determined 

from the data.   If the main record for any of the people linked to the document has a blank birth or 

death date field, Clooz will automatically insert the value from the document.  If a value is already 

present in the person’s main record, no further action is taken, unless it involve the birth date from a 

birth record, or a death date from a death record. If either of these dates are different from what is in 

the main record, the user will be asked whether to change the value or not.  If multiple people in a 

birth or death record are marked as Primary in their details forms, no attempt is made to enter the 

birth or death date into the persons’ main records. 

 

Figure 67  - Conflicting Vital Date Values 

 

Buildings 
Many people study the history of houses and buildings like genealogists study the history of their 

ancestors. Houses can have personalities, like people do.  The Building template was designed based 

on forms used by state historic preservation offices to list buildings on historic registers. While the 

building you’re interested in may not qualify for the historic register, it’s still of significance to you 

and should be documented as much as possible. 
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The Building template is a bit different than other templates in Clooz, because of its unique purpose. 

 

Figure 68 - Building Template 

The Building Template is displayed by selecting Buildings on the Explorer Bar, and then selecting 

Add Building. 

Add a Building ID. This ID can be anything you need it to be.  Try to make the Building ID useful to 

you. In the example above, the ID is the street address of the building being entered. 

Select a Style from the drop-down list.  The architectural style of the building may already be known 

to you, or you can research the style through building records, or web- sites dedicated to 

architectural styles, such as Architectural Styles of America at 

<http://jan.ucc.nau.edu/~twp/architecture/>. If the style you’re looking for is not already in the Style 

list, just type in the style and hit your tab key and the style will be added to the list. 

Add the street address of the building.  The Formerly field is where you would record street name 

changes.  For instance, in Plymouth, Michigan, Penniman Avenue was called Sutton Street until 

1912.  If you reported the address as Penniman Avenue in order to identify the location today, Sutton 

Street could be added to the Formerly field for historical understanding. 

Complete the location fields as appropriate.  The fields that have down arrows (also called 

Dropdown Lists) next to them have entries that are used frequently during data entry. The data 

contained in these dropdown lists can be reused, so you don’t have to retype the same places 
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repeatedly.  If you make a typing error in one of these fields, you can correct it by selecting the Lists 

item on the explorer bar.  Clooz is pre-loaded with all the U.S. states (both spelled out and in postal 

abbreviations), Canadian provinces, and months.  You can add more places to the dropdown lists, 

such as “Wisconsin Territory” or a foreign state or province; by just typing in the new entry and 

hitting your tab key to advance to the next field. 

Complete the Year Built field, if known, and then select your source, attach digital files, and link 

people or businesses as we discussed under the General Template Features section.  

If you have historical information on the building, you can add it by clicking on the Historical 

Information button on the building form.  Fill in as many of the fields as you can.  These are the 

fields that correspond to historic preservation forms used to register buildings on the historic 

register.  You may have compiled this information from a variety of sources.   This button is unique 

for buildings. 

 

Figure 69 - Historical Information form for Buildings 

 

Press OK to save the forms you have open and the building will now appear in the main grid list. 
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Censuses 
This section will show you how to enter all of your census records from the United States, Canada, 

United Kingdom, Ireland, France, Germany, Norway, and elsewhere. 

Template forms are available for U.S. federal, Canadian, U.K., Irish, French, German, and 

Norwegian censuses: 

• U.S. federal decennial population schedules from 1790–1940 

• U.S. federal non-population schedules from 1850–80 

• Canadian decennial population censuses from 1852–1916 

• Canadian non-population schedules where available 

• U.K. decennial censuses from 1841–1911 

• Irish surviving censuses for 1901 and 1911 

• French censuses 1831–1901 

• Mecklenburg-Schwerin (Germany) census for 1819 

• Norwegian censuses for 1801–1900 

• Other types of censuses in two generic forms—the head of household and every member in 

the household   (for censuses not having specific templates, like state censuses) 

To enter a new census record, choose the country of the census you are interested in on the Explorer 

Bar along the left side of the main screen.  For instance, if you’re working on a census from the U.S., 

select U.S. Censuses.  The U.S. Censuses category will expand so you can see all of the template 

choices available to you. 

Under the U.S. Censuses category, you have choices for Population Schedules, Mortality Schedules, 

Agricultural Schedules, Manufacturing Schedules, and the Defective, Dependent, and Delinquent 

Schedule.  Select the appropriate year from the choices available on the list.  The most commonly 

used category is the Population Schedules, where your ancestors are listed in their neighborhoods. 

The document template will then appear for the year and category of census you requested.   Fill out 

the document information describing the area of the census you are working in.  Include the location 

information based on what appears on the census pages you are looking at.   Do not mix census 

information from different districts in the same document.   Rather, you should create additional 

census documents for different districts, or even different households if that is your desire. 

Source information and digital files should be entered, and people should be added as described in 

the General Template Features section.  Only some of the census schedules allow businesses to be 

added. 
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The details form (displayed by double-clicking on a person in the Link Grid or by pressing the New 

button) will vary greatly between the different census schedules and years.  One such form is shown 

below as an example.  The fields on the form will match the columns on the census form. 

 

Figure 70 - U.S. 1850 Census Details Form 

Enter the information exactly as it appears on the census document for that person.   You can note 

any suspected errors in recording in the Remarks section.  Once you complete the data for that 

person, press OK to save it. 

If you edit the details of one person, and then select another person from that same document (or 

press New) for which no details have been ever entered, you will be asked whether you want details 

filled in based on the previous person. 

 

Figure 71 - Auto-fill Personal Details 

This only applies to certain fields that are likely to be constant for the same household, such as 

surname or dwelling information.   You can always change those values when the details form 

appears, so this does reduce your typing somewhat.   If you return to a document record that was 

only partially done, you can cause this feature to be invoked by just editing one person (and then 

immediately press OK in the details).   Otherwise, it will not be asked for the first person being 

added. 

You will also notice in the details form that some of the fields, such as sex, will automatically 

capitalize the first letter of whatever is entered (say “M”).   This allows for consistency in the 

appearance of your data without having to constantly search for the shift key. 
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Census Substitutes 
What are census substitutes? In some countries, census records are not available for various time 

periods.  Reasons vary, but the records are not available. Therefore, we need to turn to other records 

to fill in gaps created by missing census records.  There are a variety of records that can fill these 

gaps, including directories, tax and voting records, and in Ireland, valuation and tithe applotment 

records. 

Clooz contains templates for four different types of directories: 

Population—these are commonly called city or county directories 

Religious—these are church directories 

Farm—these are rural directories 

School—these are school directories or yearbooks 

In addition to the directories, there are also templates for tax records, voting records, Irish valuation 

records, and Irish tithe applotment records in the Census Substitutes category of Clooz. If you’ve 

mastered entering censuses, entering census substitutes should be a snap.  You enter data the same 

way in all templates in Clooz.   

To create a new census substitute record, choose the Census Substitutes category, and then select the 

type of record you want from the expanded list.   For example, the Population Directory template 

(see Figure below). 

 

Figure 72  - Population Directory Template 
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This is a fairly straight forward document.  On this form you would enter the location for the 

directory, and then link in the people.   Double-clicking a person would display a form to enter 

details for them. 

 

 

Figure 73 - Population Directory Details Form 

Documents 
This section on Documents shows you how to work with virtually any type of genealogy records 

other than the censuses, census substitutes, and images.  You’ll discover here how to enter 

documents, including: 

Birth records 

Marriage records 

Death records 

Funeral/burial records 

Deeds 

Correspondence 

Naturalization records 
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Passenger lists, both early and later (early passenger lists did not contain a lot of information; if the 

list you’re working with contains a lot of details, select the later passenger list choice) 

Social Security Death Index (SSDI) 

Generic documents—many other records, such as family history notes, pedigrees, and family group 

sheets. 

Don’t enter any census or census substitute records in Documents. They’ve got their own templates 

in their respective categories. 

If you have a document that is not close to any other type of document, you should always be able to 

make use of the generic document.   When judging how well your document matches one of Clooz’s 

templates, be sure to examine the detail forms, not just the document templates. 

 

Figure 74 - Generic Document Template 

 

Like the other document templates, refer to the General Template Features section for instruction on 

using most of the items in this form.   
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The Generic Document template allows you to define the event to which it applies.   This will allow 

you to sort records entered using this form by type of event. 

 

 

Figure 75 - Generic Document Details Form 

 

 

Images 
You can finally organize all your family images in Clooz, and you will never have to search for a 

picture of Uncle Rob again.  It will be right at your fingertips, that is if you have a picture of Uncle 

Rob and he is in your family and you’ve put his image in Clooz.  Anyway, you get the point. 

What’s more, you can even print a photo record with thumbnail pictures for each ancestor in 

Clooz—just a great way to organize your pictures and see what you have at-a-glance.  It will impress 

your family and even your ancestors! 

This section explains how to create a new image record and insert a digital photo in it. 

If you click on the Image button on the Explorer Bar, you see that there are two types of images 

listed:   Map and Photo.   Since maps and land diagrams are common in family history research, they 

can be classified separately from other photographs for sorting purposes. 

The photos and maps you enter under this Image category are treated slightly differently than those 

you might have attached to other documents and sources.   The document and source images are 
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typically either a direct image of a document or transcription.   The images in this Image category 

are usually photographs of a place, person, or event.   The Image template, unlike other documents, 

only has room to attach one digital file.   Each photo or map should be given its own Image record. 

When you click on the Image button (Explorer Bar), the list of images appearing in the main grid 

area are those entered using these Image templates, and do not include digital files that might be 

attached to documents and sources in your database. 

 

 

Figure 76 - Images Template 
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The details form for photographs is extremely simple.  

 

Figure 77 - Photo Details Form 

 

The map detail form has many more specific fields that you can use. 

 

Figure 78 - Map Details Form 
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Sources 
 

We know some people aren’t diligent in properly documenting sources.  We won’t lecture you on its 

importance. But we will say that Clooz can make the task a little easier.  Clooz provides forms to 

document your information. They include fields for Source Titles, Authors, Publishers, Repositories, 

Call and Roll Numbers, and Remarks, and more.  You only have to enter this bibliographic 

information once because Clooz memorizes it for you. 

The Clooz source templates are based on Elizabeth Shown Mills’ book Evidence! Citation & Analysis 

for the Family Historian (Baltimore: Genealogical Publishing Company, 1997).    Elizabeth Shown 

Mills does have a more recent book, Evidence Explained – Citing History Sources from Artifacts to 

Cyberspace, Second Edition, revised (Baltimore: Genealogical Publishing Company, 2012).   Due to 

the lack of standardized data exchange formats for source information, movement of source 

information between Clooz and lineage-linked software packages has proven to be a real challenge.  

Work is continuing in this area.   However, since Clooz is more of a research tool than a publication 

tool, your main objective in using Clooz for the time being should be to capture all of the necessary 

source information, and less on the fine intricacies of detailed source formats, since formats tend to 

get disrupted anyway when the information is moved into another program. 

Before you start, realize the difference between a source and a record. In short, a source is where the 

record originates and a record is the information you’re interested in within the source. For instance, 

a published city directory would be a source. The page of the directory containing your ancestor’s 

name would be the record that contains the information you’re transcribing into Clooz. You would 

fully cite the city directory on the appropriate Clooz source template, but the information contained 

within the directory would be entered into a Clooz template for city directories. 

Clooz contains eight different source templates. The source templates should be selected based on the 

source’s original format when an exact image is shown, not based on how you looked at the source.  

For instance, the manuscript census that each of us has looked at on microfilm or on Ancestry.com is 

actually an unpublished document in its original format.  Think of it as a bunch of pages, and that’s 

what constitutes a “Document” in the Clooz Source templates. The U.S. census became a publication 

when it was distributed by the National Archives on microfilm.  But first it was a document, and 

that’s what you would need to select for a Clooz Source.  You’ll be able to record the microfilm or 

CD publication information about censuses and other such documents within the Source template.   

However, if the census data was transcribed or somehow modified to be in a textual database for 

instance, the transcribed database would be the appropriate source to cite. 

Each of these Source templates will be explained in this section: 

 

Book Certificate Document Image   

Journal Newspaper Register Website   
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There’s no trick to this, a book is a book.  In essence, a book is something that has been published in 

print format.  Webster has multiple definitions for a book, but the one that applies here is “a set of 

written, printed, or blank sheets bound together into a volume.”  Examples of book sources include 

printed genealogies, city directories, printed histories, county histories, and printed transcribed 

records.  

 

Figure 79 - Book Source Template 

You should notice that this template (as with most of the source templates) has tabbed pages at the 

top and bottom of the form.   The second page (tab) at the top is where the Microform/CD 

information gets entered. 

The bottom set of tabs offers some tools to use.   The Quick Capture text box is simply a multi-line 

text box, but it also supports clipboard functions (cut/copy/paste) and more importantly, drag and 

drop operations.    You could be looking at an online document where the data provider has a source 

citation on the screen.   Just highlight the whole block of information on the web site and drag it into 

the Quick Capture box.   From there you can copy/paste segments to the appropriate fields. 

The Digital Files tab provides means to save digital attachments or URLs, the same as in the 

document templates. 

A certificate is something that you obtain from a clerk’s office, government agency, or other 

authority to prove that an event occurred.  Webster says a certificate is “a document containing a 

certified statement especially as to the truth of something.”  Examples of certificate sources include 
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birth, marriage, and death certificates, certifications in various professional fields, and a baptismal 

certificate.  

 

Figure 80 - Certificate Source Template 

A document, generally speaking, is something that is unpublished.  You might find documents in 

archival collections, in libraries, or in personal papers.  Webster says a document is “an original or 

official paper relied on as the basis, proof, or support of something.”  Examples of document sources 

are letters, manuscripts, family papers, and the manuscript census as described earlier. 

 

Figure 81 - Document Source Template 
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An image is just what it sounds like, a picture of something. Webster describes an image as “a 

reproduction or imitation of the form of a person or thing.” Examples of image sources are 

photographs, negatives, and maps. 

 

Figure 82 - Image Source Template 

A journal is published periodically in magazine format, or, more recently, on the Web.  Journals 

typically come out less frequently than newspapers, therefore they are usually valued more for their 

feature content than their news content.  Webster defines a journal as “a periodical dealing especially 

 

Figure 83 - Journal Source Template 
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with matters of current interest.”  Examples of journal sources include the National Genealogical 

Society Quarterly and the New England Historical and Genealogical Register. 

Everyone should be familiar with newspapers.  Today newspapers come out daily, biweekly, or 

weekly, and contain news for a given locality. In our ancestors’ times, newspapers might have been 

published less frequently, but were still considered newspapers. Webster describes a newspaper as “a 

paper that is printed and distributed usually daily or weekly and that contains news, articles of 

opinion, features, and advertising.”  Select Newspaper as a source if you have an obituary from a 

newspaper.  The newspaper itself is the source, but the obituary would be entered as a Clooz generic 

document. 

 

Figure 84 - Newspaper Source Template 

 

Registers are most frequently unpublished records kept regularly by clerks or authorities, frequently 

written in blank books with printed lines or formats.  Webster says a register is “a written record 

containing regular entries of items or details.”  Register source examples include ledgers containing 

tax or voting lists, business records, and church records. 
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Figure 85 - Register Source Template 

By now, most of us are familiar with websites.  Anyone with a little time and storage space can put 

up a website on the Internet.  Many of us find valuable genealogical information on database search 

sites, such as Ancestry.com or HeritageQuest.com. Citing the information found on these websites is 

useful, but it’s usually a good idea to download an image of the record found, or print a copy of the 

page of interest, as websites change rapidly. 

 

Figure 86 - Website Source Template 
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Some additional tips with sources: 

Evaluation of Source. This field appears on all the source templates, and is for you to write notes to 

yourself about the source and how credible you feel it is.  If the source that you are entering has been 

either microfilmed or published on a CD, click on the second tab labeled “Microform/CD 

Information.”  This is where you will enter the rest of the information about a source that you 

viewed in other than its original format.  Try to fill in as much information as possible so you could 

find this source again, if you needed to.  If you saw the source on a microfilm available through the 

Family History Library, you would record the call number and item number on this second tab. 

There’s one field you should pay attention to, especially if you selected the wrong source type.  The 

“Source Type” field (the last field on the second tab) shows you what type of source you are 

working on.  If you have selected the wrong source, click on the down arrow and select the correct 

type from the list.  Close the source form (Ok button). When you open it again, the proper source 

template will appear. 

If you converted your data from a previous version of Clooz, some source entries were created for 

you. These will need your attention.  In earlier versions of Clooz, census and photo records didn’t 

have source entries.  The information about these was on the input screen. In order to standardize 

data input in Clooz, all templates now are set up similarly and require source input on these source 

templates.  Therefore, during conversion, Clooz created census and image sources for you, and 

arbitrarily gave them titles.  Census records were given a title such as “1870 US Census 002” and 

were converted as Document sources.  The source title for photos was taken from the description 

field, and images were converted as Image sources.  You should spend some time making these 

sources conform to your style of citing sources. 

Additionally, since Clooz didn’t know what type of source your existing sources were, they were all 

(except censuses and photos) converted as Book sources. You should go through each imported 

source and select the correct source type, based on descriptions above. 
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Repositories 
 

Each source has a field for you to select the repository where the source was held.   This is most 

important to record for documents that are unpublished and perhaps only held by this repository.  It 

is less important to document where you found a copy of a published book that might be in libraries 

all across the globe.    

To display the list of all repositories, click on the Repositories button on the explorer bar.   The list 

of repositories will appear in the main grid area.   Repositories also appear on the source forms as 

drop down lists from which you choose the appropriate entry.   If the repository you used is not on 

the list, press the New Repository button, and complete the form that appears. 

 

Figure 87 - Repository Form 

 

To enter a web site address in the URL field in the middle of the repository form, drag the small icon 

to the left of the URL in your web browser program into the repository’s Website field.   Pressing 

the view button will call up the web page in your default web browser.    To delete or change the 

URL, edit it directly as a text box. 
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You can edit repository records by one of three methods: 

Double-click the repository item when displayed in the main grid area. 

Right-click on the repository item in the main grid area, and select Edit Item from the menu that 

appears. 

Right-click on the repository appearing in a source form, and select Edit from the menu that appears. 

In any of those cases, the Repository Form on the previous page will be displayed containing the 

data for the record you selected. 

There is an additional capability for you when you right-click on the repository list in the main grid.  

By first selecting multiple repository records (by clicking with the CTRL key held down), the Merge 

Repositories item becomes enabled.   When you have duplicate repositories listed, use this command 

to merge them into one record.   All of the sources linked to those repositories will be switched to 

the new merged repository. 

 

 

Figure 88 - Repository List Context Menu 

 

 

Edit Lists 
Dropdown lists or boxes throughout Clooz save you from retyping frequently used information 

you’ve already entered or that is pre-loaded in the program, such as months, surnames, given names, 

and localities. You’ll know if it’s a dropdown list if it has a down arrow at the right end of the field. 

Click on the small Down Arrow to see the Dropdown List. 

You may occasionally need to change this memorized data, such as delete a duplicate or unused 

entry or correct a typo. You can do this directly from the Clooz explorer bar or menu. 

To edit a Dropdown List from the explorer bar or menu, take these actions: 

From the Clooz explorer bar, click Lists. (Or from the menu bar, click Edit then click on Lists.) 
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From either the explorer bar or the menu bar, select the list you want to edit: 

Cities  Names  Subjects 

Counties Nationalities Surnames 

Countries Occupations Townships 

Districts Parishes Types 

Establishments Places Villages 

Events Religions Item Type 

Farms Roles Media Type 

Given Names States  

Locations Streets  

 

 

A list editor form would appear as follows:  

 

Figure 89 - List Editor Form 

 

Scroll through the list you’ve selected to find the entry that you need to edit or delete.  You will 

warned if you’re trying to delete the entire entry that is used in the database.  However, if you have 
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placed the cell (2nd column) in edit mode (by clicking in it), the delete action applies to the text 

characters in that field (vs the whole record).   Thus you could end up deleting the text, leaving a 

blank field to be used throughout the database.   If you accidently delete the text, right-click the 

second column entry, and select Undo.    

The figure below shows the entry in edit mode, with the “I” shaped cursor.   Deleting text while in 

this state will not check for usage of that entry in the database.  Right clicking the edit field will give 

a context menu with Undo and Copy/Paste options.  

 

Figure 90 - Editor Cell in Edit Mode 

 

To select lines without activating edit mode, click on the first column.   All of the lists, other than 

Names, have a context menu for checking usage and merging items.  Right-click on the left column 

to display the context menu containing these commands. 

 

Figure 91 - Place List Editor Context Menu 

 

The Check Usage function will display a list of all the records which use that particular list item.   

 

Figure 92 - Window Showing Results of a Usage Search 

 



 

88    Entering Records Clooz 3 User Manual 

If you select more than one list item, the Merge Items command is enabled.   When list items are 

selected to be merged, a small window will pop up to let you choose which of the duplicate text 

fields should be the phrase or name used for all the data locations currently filled with any of the 

items selected for merger.   Pressing Cancel would undo the merge operation. 

 

 

Figure 93 - Text Selection Window for Merged Items 

 

 

 

 

 

 

  



 

Clooz 3 User Manual Reports    89 

Reports 

 

The Reports Menu (see Figure 94) allows you to select the type of report you want to generate. The 

choices are similar to other choices in Clooz: People, Businesses, Buildings, Censuses, Census 

Substitutes, Documents, Images, and Sources. You can print a report of all people, all censuses, all 

census substitutes, all documents, all images, and all sources, or you can print “selected” versions of 

the same choices (i.e., all censuses for 1840), or you can print a “select” report of an instance of the 

above choices (i.e., the 1840 census from Detroit, MI, containing the Dohertys). You can also print a 

report for one document from that particular document’s form. 

There are various choices under the Reports Menu that allow you to filter your reports how you 

would like them to appear. The Help menu will take you to Clooz Help, will allow you to connect to 

various pages on the Clooz website, and will take you to a screen that gives you information about 

Clooz, including the version number and serial number. 

People 

 All People in Clooz, sorted by ID, Alternate ID, or Surname 

 Selected People in Clooz, sorted by ID, Alternate ID, or Surname 

 An individual, showing all documents (or just the primary documents) that person is linked to  

 

Businesses 

 All Businesses in Clooz, sorted by ID, Alternate ID, Name, or Owner Name 

 Selected Businesses in Clooz, sorted by ID, Alternate ID, Name, or Owner Name 

 A business, showing all documents that business is linked to 

 

Buildings 

 All Buildings, sorted by Building ID, Address, City, Township, County, State/Province, 

Country 

 A specific building with linked people, or with linked businesses, or with no people or 

businesses 

 

Censuses 

 All Censuses by Year, Personal File #, Surname, Country, State/Province, County 

 Selected Censuses by Year, Personal File #, Surname, Country, State/Province, County 

 A specific census 
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Census substitutes 

 All Census Substitutes by Event, Personal File #, Year, Surname 

 Selected Census Substitutes by Event, Personal File #, Year, Surname 

 All Directories by Country, State/Province, County, Town- ship, City 

 Selected Directories by Country, State/Province, County, Township, City 

 All Tax Records by Country, State/Province, County, Township, City 

 Selected Tax Records by Country, State/Province, County, Township, City 

 A specific census substitute 

 

Documents 

 All Documents by Event, Personal File #, Year, Surname 

 Selected Documents by Event, Personal File #, Year, Surname 

 A specific document 

 

Images 

 All Images by Image #, Event, Subject 

 Selected Images by Image #, Event, Subject 

 All Maps by Image #, Event, Subject 

 Selected Maps by Image #, Event, Subject 

 All Photos by Image #, Event, Subject 

 Selected Photos by Image #, Event, Subject 

 All Photos with People by Image # 

 Selected Photos with People by Image #, Surname 

 A specific image 

 

Sources 

 All Sources by Title, Author/Creator, Source Type, Location 

 Selected Sources 

 A specific source 

 

Research Logs 

 All Research Logs by Log ID 

 Selected Research Logs by Log ID, Surname 

 A specific Research Log 

 
 

Selecting a Report 
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1. Click on Reports from either the Clooz explorer bar or the Clooz menu bar. You can also print 

a specific report from any form in Clooz. 

2. From the Clooz Report screen, select the category for the report, ex., People, Censuses, 

Images. 

 

 
Figure 94 - Report Selection Form 

 

3. If a + sign is next to an item, click on the + sign to open up that category to see the choices 

available.   A grid with column headings appears on the right side of the screen. 

4. If you choose one of the Selected type of reports, you can choose which items to include on 

the report by clicking in the check box next to each item.  To clear the selections, click on the 

Clear Selected Records button. 

5. If you want to see a report for one individual, click on People and then Individual, or choose 

that person from the People list on the Clooz Explorer Bar, and print the report from that 

person’s form.   The list of all of your people will be in the grid on the right.   To find someone 

quickly,   use the Search bar above the grid area.   For example, with the Starts With condition 

selected, enter some text and press Enter.   You will jump to the first record beginning with 

those letters (in the field designated for the search).   Once you’ve found the person, highlight 

the name and click on the Run Report button, or double click on the person’s name to run the 

report. 

6. Once you find the report you’re looking for, click on the Run Report button. Generation of the 

report may take a few seconds. Your report will be shown on the screen once it’s generated. 

7. When the report appears on the screen you will have several options available on the toolbar, 

as shown in the next Figure. 
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Viewing a Report 
Once you have clicked the Run Report button, the report will be generated and displayed in a viewer 

window.   Some reports take a few seconds to be generated, depending on the specific report 

selected. 

 

Figure 95 - Report Viewer Window 

 

The Report Viewer window, like the main Clooz program window, will appear at the same location, 

size, and state as it was when last closed. 

The Toolbar at the top of the window provides a few functions to work with the report. 
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The first option on the left is the Export option. If you select this option, you can export 

your report to the following formats: Adobe Acrobat (.pdf), Crystal Reports (.rpt), 

Microsoft Excel (.xls), Microsoft Word (.doc), Rich Text Format (.rtf), and XML.  Clicking on the 

export icon will open a dialog box to select a filename (and location) to contain the exported 

data.  The format of the file can be changed by using the drop down list at the bottom of this 

dialog box. 

 

The Print Report button calls up a printer dialog box, where you can change printer 

settings and then send the report to the printer.  The default paper size in Clooz is Letter.  

If you live in an area that uses A4 paper, you will need to change the paper size in your printer’s 

settings.  Most of the reports in Clooz are laid out in landscape format.  Some print on multiple 

pages wide.  Some are laid out in landscape mode on legal- size paper (8 1/2” x 14”).  You will 

be warned if you need to load legal paper for a report. 

 

The third option is for copying selected text to the clipboard.   If you highlight a selection 

of text directly on the report, pressing this button will copy it, and then you can use the 

paste function to insert it in another program document, such as with Microsoft Word.   The 

layout format is not maintained, but the order of appearance is. 

 

The fourth option, the tree toggle, shows the groupings for a report. It is only useful to you 

if you want to see, on screen, a particular grouping. 

 

 

The next set of options take you, respectively, to the beginning of a report, 

to the previous page, to the next page, and to the end of a report, if your report is more than one 

page. 

 

The next box shows you what page you are on and the total number of 

pages for the report. 

 

The binoculars allow you to search for text within the report.  If the text is found, it is 

highlighted. 

 

The final option is a zoom setting. You can change the size 

of the report on your screen from this drop-down list. 
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Exporting to Other Programs 

Clooz currently supports two ways of exporting information to the database files of other genealogy 

programs, either using the Data Transfer Manager or the Document Export function (added in Clooz 

Version 3.3).  The Data Transfer Manager is more limited in the types of data that can be imported 

or exported (individuals and sources), but can perform bulk operations.   The Document Export 

function has a very extensive ability to export essentially any type of data in Clooz, but only applies 

to one document at a time.   Each will be covered separately in the following sub-sections. 

Clooz uses two methods for interfacing with the various other program databases.   One is by 

directly reading and writing to the external database file.  The main advantage of this approach is it 

provides for a stronger linking or synchronization between Clooz and the other program.   Clooz can 

track the RIN (record identification numbers) in the other program for individuals who have been 

linked.   For those programs not providing direct read and/or write access to their files, Clooz will 

import and/or export using a GEDCOM file as the transfer vehicle.   In those cases, this GEDCOM 

file must be merged into the external program using its own import or merge capability.   This could 

likely result in duplicate individuals in the external program, and thus the program’s merge 

capability is required to eliminate the duplication.  The actions required for each program will be 

discussed later.   The following Figure identifies the external programs Clooz interfaces with and the 

methods used to import and export data. 

 

Program Import Method Export Method Linking of RINs 

Legacy Family Tree Direct Read Direct Write Automatic 

RootsMagic Direct Read via GEDCOM Semi-Automatic 

The Master Genealogist Direct Read (via 

Genbridge) 

via GEDCOM Not updated for Exports, 

TMG family structures not 

read 

FamilyTreeMaker via GEDCOM via GEDCOM Not updated for exports 

Family Historian Direct Read Direct Write Automatic 

    

Figure 96  External Programs Supported by Clooz 
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Exports Using the Data Transfer Manager 
 

Exporting data with the Data Transfer Manager is very similar to the methods used in importing, 

except the selections are made on the Clooz list (right side of Data Transfer Manager), and the 

Export button is used. 

In the following example, suppose you want to place the Crotty family in Legacy.   The first step is 

to check off the records we want to export. 

 

Figure 97 - Selections Made for Exporting 

 

You then click on the Export button.   Clooz displays a confirmation message, and you click on Yes. 

 

Figure 98 - Export Confirmation Message 

Clooz then performs the export operation.  When completed, the ID or RIN values that Legacy 

created for the new records are now shown on the Clooz lists. 

 

Figure 99 - Updated Lists after an Export 
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Exports Using the Document Export Function 
The Document Export capability was first implemented in Clooz version 3.3.  Using this feature you 

can export any of the individual items appearing in Clooz grids and the Composite View.  You can 

therefore export an individual person, source, or repository, even though we have called this the 

Document Export.  It gets its name from its powerful ability to output nearly all of the information in 

a Clooz document, transforming the information into various events in the other program for the 

people involved based on the information contained in the document.   

Unlike the Data Transfer Manager, where you designate the database to be used when you use the 

feature, the Document Export function always exports the selected Clooz data to the external 

database currently designated as “Primary” in the External File Links view.   Therefore, you must 

ensure that the database you want to export data to is listed in the External File Links view, 

and has a check mark before the “Set as Primary” command in context menu (right-click).  
The file designated as Primary will appear in bold font in the list of files.   If the database you wish 

to export data to is not in the list, simply click on the option in the External File Links Explorer Bar 

group to open a database of the appropriate type.  When the Data Transfer Manager appears, simply 

close it unless there are tasks you wish to perform there in bulk.   Exports designed to create events 

in external databases can only be done on a single document basis though, using the Document 

Export function. 

Whenever an external database is designated as Primary in the External File Links list, an additional 

menu command (Export Item) is added to the context (right-click) menu for all of the grid and 

Composite View displays.  Click on this command to begin the Document Export process. 

 

Figure 100  - Context Menu with Export Item command 

 

The Document Export form will appear when you click on the Export Item command after right-

clicking a document of any type.   It is on this form where you can select which people (and their 

individual events) get exported, as well as edit the information to be saved in the other database.   

When everything is reviewed and determined to be what you want to export, you click the Export 

button, and then follow the procedures required for that particular database type. 
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Figure 101 - Document Export Form 

 

The Document Export form contains five different pages of data, which you select by clicking on the 

appropriate tab. 

 

People Tab 

The People tab (selected in figure below) on the Document Export form shows the page of 

information about the persons linked to the document being exported.   It will contain the same list 

of people that you would see when viewing the document template.   You can select which people 

are to be included or excluded in the export using the checkbox in front of their names.   The names 

that appear in this list are the common forms of the names assigned to those people in their main 

records.  It is not necessarily the same name or spelling that was used in the document (that will 

show up later in the Events page).   Expand a person’s record by clicking on the small plus sign in 

the far left column.   Each of the name components, sex (if determined by this particular document), 

and the birth/death dates contained in the persons main Clooz record can be included in or excluded 

from the export using the checkbox on each line.   The data itself can be edited by clicking on the 

item in the Data Values column.  It is important to note that any changes to the data values in the 

Document Export form will not be saved back in the Clooz database.   It is only a means to adjust 

the formatting of data values to better suit display in external program.  Date values will be 

displayed in a format supported by the external program.   
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Figure 102  - People Page with Data Value Editor 

 

The record identification number (RIN) of the record in the external database can be edited on this 

page during the export process when the external database type is one that Clooz directly reads.  The 

RIN column value would appear on the top level line for each person (where their name and 

summary of vital dates appear, not on the individual data component lines) if the person in Clooz 

was previously linked to a record in the other database (prior to beginning this export).   In such a 

case, the RIN field is not editable, and if you believe it to be incorrect, you would need to make any 

changes to the people linked to the document back in the document template, or remove the link in 

the Data Transfer Manager.   This is not a trivial decision, as you may have already exported events 

and data for this person at a previous time.   Unlinking the person in Clooz from the external RIN 

does not change any data or events in the external database. 

 A blank RIN value indicates the person is not currently linked to the external database.   In this case, 

the field is editable.   If you know a record already exists for the person in the external database, you 

could type it in here.   Otherwise, at the time the actual export is executed, those people with blank 

RIN fields will have a new record created for them in the external program.  You can only enter RIN 

values that already exist in the other database.  Non-existing RIN values will be ignored during the 

export, and treated as a blank.   It will be more efficient if you fill in as many of the RIN values as 
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possible, since leaving it blank will result in a new person being added to the other database.   If that 

new person in the other database is a duplicate of an existing person there (as is commonly the case 

where GEDCOM files are used to transfer the information), you will need to use the tools in the 

other program to merge the people.  When you type in a RIN value, the fields in the “Current 

[External Program Name] Value” column will populate, and permit you to compare the person’s 

current data in the other database with the data you intend to export.  By default, the checkbox will 

be turned off for data fields where data in the other database is already stored.   The Clooz data for 

that item will not be exported unless you manually check the box. 

When displaying the main People grid or Composite View in Clooz, and a right-click Export Item is 

selected for that person, the same Document Export form will appear, but only the People tab will be 

visible.   This is a way of exporting individual people to Legacy (similar to what could be 

accomplished in the Data Transfer Manager), but with more control. 

 

Events Tab 

 

When a Clooz document is exported, the program will scan the information entered for that 

document to extract data that may define events for the persons contained in the document.  This is 

usually a one way process.   A birth record (perhaps a birth certificate) entered into Clooz contains 

the birth date and location information for a person, so the birth event for that person can be created 

in Legacy, for example.   However, the reverse is not true.   Simply knowing the birth date and 

location for a person in Legacy does not permit you to create a birth certificate in Clooz.      

When possible, birth events are derived from information such as age on the enumeration date of a 

census.   In such cases it is up to you to make the decision as to whether such information should be 

exported or not.   To assist your evaluation, positioning the mouse cursor over the birth date will 

provide a hint popup that tells what the basis for the determination was (see figure above).   In any 

case, exporting vital events to Legacy will not overwrite any vital event information already existing 

there.   If a birth date or location has already been entered, this new information will be added as an 

alternate value (e.g., Alt. Birth).   

Clooz version 3.3 can extract information from the census data and document types that have well 

defined fields in the template, and the information contained in them can be anticipated with a 

reasonable degree of certainty.   However documents such as the Generic Document template which 

could contain the most significant information in the free-text remarks area should not be expected 

to create all the events a human might interpret from the data.   It is only meant to get you started by 

handling the “easier” determinations.   
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Figure 103  - Events Tab 

 

When possible though, Clooz can create any of the following event types in an external database 

from the Clooz document types listed: 

 Birth (birth records and any documents providing an age as of some date) 

 Marriage (marriage records) 

 Death (death and burial records, mortality censuses) 

 Funeral (burial records with funeral field filled in) 

 Burial (death and burial records) 

 Occupation (documents providing an occupation or profession field) 

 Religion (censuses with a religion field) 

 Residence  (documents providing a street address) 



 

Clooz 3 User Manual Exporting to Other Programs    101 

 Immigration (documents providing an immigration year) 

 Naturalization (naturalization records) 

 Census (census documents) 

 Social Security Number (social security records) 

 School  (school directories) 

 Deed (deed records) 

 Land (farm directories, tax records, Irish Valuation/Tithes) 

 

You may have noticed the red icon in the figure below beside “Alta Ousterhout.”  This signifies 

there is a problem within her data.   For instance, when there are problems formatting dates with 

peculiar content, the icon will appear to draw your attention to the situation.  Typically, this will 

either involve misspelled month names (or abbreviations) or not having a space separating letters 

and numbers.  Positioning the mouse cursor over the field will provide an explanation of the reason 

for the alert.   Once the typo in the date has been corrected, the alert should disappear. 

 

Figure 104  - Alert Icon for Problem Situations 

 

The next important concept with the Events tab is the event participants group.  For most Clooz 

document types, the details forms apply solely to one of the people linked to the event (which is the 

case with all censuses).   However some document templates (notably birth record, marriage record, 

death record, deed, funeral/burial record, naturalization, and generic documents) have a checkbox 

indicating whether that person is a primary (sometimes called principal) person for the record (in 

other words, the event associated with that document is focused on them). 
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Figure 105  - Document Template with Primary Field 

In the case of a birth, the Primary person is the newborn infant.  However, in earlier versions of 

Clooz, this field was not well defined, and only was used to control whether the record appeared in 

certain report formats.  Therefore, it is quite possible you have had a different interpretation, and had 

multiple people in a document with the field checked.   Likewise, you may have only checked the 

Primary box for the infant, but were entering a list of infant births found in some register book.  To 

handle these cases, when you select to export a document of one of these types listed earlier, and 

more than one person is declared Primary (two for marriage records), a special form will pop up to 

allow you to specify how you want the people to be handled. 

 

Figure 106  - Form to Clarify Multiple Primary Persons in the Document 
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In our birth record example, you would normally use the lower option and check the box associated 

with the person born.   If it was a register type document and all the primary people do have their 

own birth information in the document details, then select the upper option.   If you have a mix, then 

you may need to export the document multiple times, each time selecting a different baby.   

Alternatively, you could check the upper option and then in the Events Tab, uncheck the birth events 

generated for what normally would be witnesses.   A witness here would be any person having a role 

in the event other than the primary person(s). 

When exporting events to Legacy 7.5 or earlier, Legacy does not support the concept of witnesses, 

so Clooz will only enter information about the event for the primary person(s).   However, beginning 

with Legacy 8, Legacy is supporting the concept of shared events, where the “owner” of the event in 

Legacy is equivalent to the Primary person in Clooz, and the witnesses will tie in (or “share”) that 

event along with a designation of their role.   Clooz 3.3 will setup all of the witness sharing when 

exporting to Legacy 8.   Otherwise, shared events / witness roles can be export to RootsMagic, 

TMG, and Family Historian.   FamilyTreeMaker does not support shared events. 

In the case of all other Clooz document types, such as censuses and census substitutes, Clooz will 

treat all of the people linked to the document as primary.   Each will get their own event in Legacy, 

whether they had the role of Head, Wife, Son or Daughter, etc.     

In many cases, especially with censuses where all family members are listed, a summary of useful 

information is added to the event in the Notes field.  So in a census family, each person would have 

this summary in their census event notes (as shown in Figure 107).  This is editable in the Events 

Tab, by expanding the lines under a person.  You can also see the Alternate Name or AKA field, 

which contains the name of the person as it was entered on the document.  Like any element, if you 

do not want an AKA entry for each document you are exporting, just uncheck this box.   But if you 

do, there will be no record of what the actual form/spelling of the name was for the person in that 

document (except perhaps in the Notes).  

 

Figure 107  - Additional Entry Lines for Each Person in an Event 

 

Finally, the lines of data comprising the Source Detail (what links the event to a Master Source) are 

available for any last minute cleanup or reformatting.   Any digital images you had attached to the 

document in Clooz will be listed under the Source Detail Media, which can further be expanded to 

edit the captions and description fields.  These are typically automatically filled with the filename for 

the file and any description that had been entered into Clooz.   The same media image links are also 
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setup in the external database for the event (see Figure below).   Most programs only use links to the 

image on your disk, no substantial duplication is occurring.  Check your program manual to see if 

media files are duplicated each time they are referenced. 

 

Figure 108  - Media Attached to Events 

Source Tab 

In Clooz, there is only one source per document.   This source, assuming you are following best 

practices and have entered one, is contained on this page for editing. 

 

Figure 109  - Source Tab 
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The checkbox labeled “Cite this source” controls whether this source will be cited in the events that 

are being created in your external database.   If this source in Clooz has already been linked to an 

equivalent external entry, an additional set of buttons will appear as seen in the next Figure.   Here 

you choose whether to cite the events to the copy of the source already in the other database, or to 

create a new source record (perhaps with some modified data values).  This function is only 

available with databases to which Clooz has direct write capability. 

 

 

Figure 110 - Sources Already in Legacy 

 

 

Like several of the remarks fields on other tabs, you will see that Publication Facts field in this 

source gets rather lengthy and is cutoff.   When you see an ellipsis (…) at the end, hover the mouse 

cursor over the field to see the entire text. 

 

Figure 111  - Pop up Display of Full Text 

When editing a field like this, you will see a button on the right side of the edit field.   You can either 

edit the text within the normal one line text, or in a multi-line editor (which supports separation of 

the date into lines. 
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Figure 112  - Editing Data with Multi-Line Edit Button 

 

 

Figure 113  - Multi-line Text Editor 

 

Similar to exporting an individual person, you can go to the list of Sources using the Clooz Explorer 

Bar and right click a specific source, and select Export Item from the context menu.   The Document 

Export function appears, but only the source tab (and associated repository) will be visible.   This 

allows you to export a single source without going to the Data Transfer Manager. 

There are several options that can be set in the Options form (see Edit menu).   An option is 

available to always cite the document’s source for each person’s name (whether or not it exactly 

matches the name in the document).   The other option moves source details into the title of the 

source (source splitting), resulting in a larger number of sources, versus maintaining separate citation 

details for the various details under a fewer number of master sources (source lumping). 

Note that if a document has no associated source, information cannot be entered into the source 

fields on this export window.   Sources must be created within the standard Clooz document editing 

capability.   The alternative would be to create the source in the target program following the export, 

if you don’t want it to be in Clooz for some reason. 
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Repository Tab 

 

The Repository tab has the same capabilities as the Source tab.   You can also export an individual 

repository by right clicking it in the main view Repositories list.   The Document Export form will 

appear, with only the Repository tab being visible. 

Similar to the Source tab, a checkbox is provided for you to designate whether the repository should 

be listed with the source.   If their already is a repository having the same name in Legacy, additional 

buttons will appear to designate whether to use that existing repository, or to create a new one. 

 

Figure 114  - Repository Tab 

 

Note that if the document and source being exported has no associated repository, one cannot be 

created in this window.   To add a repository, the document’s source must be edited using the 

standard Clooz capabilities. 
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Families Tab 

 

Families are somewhat a foreign entity within Clooz (which is totally document based).   However, 

families are the critical structure in lineage based program like Legacy.   When you export a group 

of persons to any of the family tree programs, you would then have to establish any parent-child 

relationships applying to the group’s members.   So Clooz attempts to minimize the labor required 

by assisting you in establishing parent-child relationships that are to be formed by the export.  Be 

aware though that any families you “create” in this tab of the form are not retained in any way by 

Clooz.   They only get saved in the external database (not in Clooz). 

 

 

Figure 115  - Families Tab 

 

In most cases, when you export a document, when you come to the Families tab it will initially be 

blank (unless some or all of the people in this document are already linked to Legacy persons that 

are already part of families).    The two important buttons here are the Add Family and Show 

Suggested Family(s) buttons.    
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When the Clooz document presents families in a rather consistent way, such as in censuses, the 

software will attempt to determine family groups.   In censuses, this is done by ordering people into 

page / line order, and then starting a new family with each “Head” person.   This will work properly 

most of the time, but it does remain the user’s responsibility to review such output before exporting.  

When the Show Suggested Family(s) button is clicked, the suggested families are displayed on the 

page (see Figure 116). 

 

Figure 116  - Suggested Family for Export 

 

In this case it worked perfectly.   To perform this function manually, use the Add Family button, 

which provides a table for selecting which people belong in the family, and whether they are a parent 

or child.  Only two parents are allowed, and child must mean son or daughter.   If a grandchild 

appears in the census group, a second family must be started with that child and his/her own parents.  

This, like most of the external programs, only provides a way of saving parent-child relationships. 
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Figure 117  - Select Family Members 

Finally, if one or more members of the people being exported already are linked to a person in 

another database, and they are already established in a marriage or parent-child relationship, they 

will appear on the Families Tab when it is first displayed (in Italics).   Any other family members 

from the other database whether in the list of Clooz people or not will also be displayed (in Italics).   

Relationships existing in an external database cannot be changed or deleted by Clooz.   Once a 

parent-child relationship is established in the other program, you would need to use that program to 

modify them. 

 

Figure 118  - Context Menu on the Families Page 

 

The context menu (right click) on the Families Tab provides a way to add one or more family 

members, or to remove family members, or even entire families. 

The Edit Alternate ID for entire family command provides a method to enter a single Alternate ID in 

Clooz for each member of the family, as a group.   This is for users who use the Alternate ID field to 

designate different family groups. 
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Program Specific Export Procedures 
Clooz transfers information to and from the external program files by the best method available.  In 

some cases, it is by directly reading and/or writing to the other data files, and in other cases, using 

GEDCOM files as the transfer mechanism.   GEDCOM files require users to perform specific import 

or export actions in both Clooz and the other program.   The following sections describe the actions 

necessary when Clooz is linked with the various programs. 

Legacy 

Clooz interacts directly with the Legacy database (set as Primary on the External File Links list), 

therefore no special actions are necessary.   All changes to the Legacy database are made 

automatically once the Export button is clicked on the Document Export form. 

RootsMagic 

Clooz directly reads information from the RootsMagic database (set as Primary on the External File 

Links list).   However, Clooz is not authorized to write directly to the same database.   Therefore, a 

GEDCOM file is produced by Clooz for the user to import into RootsMagic.    

Immediately after clicking the Export button on the Document Export form (or Data Transfer 

Manager form), you must first select the name of the GEDCOM file which will be created to contain 

the exported information.  To simplify normal use, you might always use the same file as your 

export GEDCOM, overwriting the old file with each new export.  Just complete the import into 

RootsMagic before overwriting this GEDCOM file in a subsequent export operation. 

 

Figure 119  GEDCOM Export File Designation 
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At this point, a GEDCOM Export Status window will appear.   Clooz will stop and wait at this point 

for you to perform the import of the file you just created into RootsMagic.   You will get the best 

results by completing the import before proceeding in Clooz, as this will then let Clooz see the 

resulting record identification values for the new data in the RootsMagic database.   If you do the 

import later, Clooz will show question marks for the RIN values until the RootsMagic import is 

complete, and the RootsMagic database has been opened by Clooz to perform another import or 

export.   Clooz does not continually monitor the RootsMagic database for changes. 

You can view the list of export actions performed (important when warnings or errors have 

occurred) by clicking the View Log File button.    

 

Figure 120  GEDCOM Export Status 

Once the import (and data merger) has been completed in RootsMagic, click on the completion 

button on the GEDCOM Export Status window.   Clooz will then complete its own actions to 

determine the new RIN numbers RootsMagic has just assigned. 

As a quick review of the import operation in RootsMagic, the first step is to click on the Import… 

command in the File menu of RootsMagic.   The file selection window will appear. 

 

Figure 121  GEDCOM File Open Window (RootsMagic) 
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Select the GEDCOM file created by Clooz, and then proceed to click on the Combine Into This 

Database button and whether to enter a source (recommend No so long as the Clooz document was 

properly sourced). 

 

Figure 122 RootsMagic Import Database Selection 

 

Then click OK to accept the GEDCOM file as it is already sourced. 

 

Figure 123  GEDCOM Import Sourcing (RootsMagic) 

 

RootsMagic will then complete the import operation.   If there were any individuals, sources, or 

repositories contained in the imported GEDCOM that already were in the RootsMagic database, 
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duplication of records will result.   To correct this situation, use the RootsMagic Automatic Merge 

capability found in the Tools menu.   Clooz includes special identification values used by 

RootsMagic in GEDCOM file for individuals already linked to RootsMagic to ensure the Automatic 

Merge capability assigns them to the right people.   Variations in event information for these people 

will not disrupt that assignment. 

 

Figure 124  RootsMagic Tools Menu 

 

 

Figure 125  RootsMagic Automatic Merge Window 

 

The information should now be properly placed in RootsMagic, and you should now go back to 

Clooz and click on the “I have completed the import…” button.    
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This procedure may change with a future RootsMagic release, if they provide a special Clooz import 

capability that would perform the automatic merge function automatically at the end of the import, 

avoiding the need for the additional user interaction. 

Finally, you may find it helpful to turn on the display of record numbers for individuals in 

RootsMagic, so that you can reliably identify matching people with those in Clooz (where you can 

turn on the RIN column for the list of people).   In RootsMagic, go to the Tools menu, File Options 

item.   In the File Options window, go to the General tab, and set the “Number to display after 

name” to “Record number (RIN).” 

 

The Master Genealogist 

 

Clooz reads information from The Master Genealogist (TMG) database files (set as Primary on the 

External File Links list) using the Genbridge program support library provided by Wholly Genes.   

However, Clooz is not authorized to write directly to the same database.   Therefore, a GEDCOM 

file is produced by Clooz for the user to import into The Master Genealogist.    

Immediately after clicking the Export button on the Document Export form (or Data Transfer 

Manager form), you must first select the name of the GEDCOM file which will be created to contain 

the exported information.      

 

Figure 126  GEDCOM Save As Window (for TMG) 

Since Clooz cannot reliably determined how TMG assigns the record numbers for individuals being 

exported, no attempt is made to link the individuals on export.   Thus the window that appears in the 

RootsMagic procedure, for instance, does not appear when exporting to TMG. 
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At this point (or later), you can now import the GEDCOM file created by Clooz into TMG using the 

Import… command in the File menu of TMG.   The Simple Wizard should work fine, and you 

should select the import file type as “GEDCOM v4.0, v5.5 (*.GED)”.   Locate the GEDCOM file 

you created from Clooz, and proceed through the wizard steps.    

As with other imports of GEDCOM files, you will need to merge any duplicate individuals using the 

TMG tools for that purpose. 

FamilyTreeMaker 

Clooz is not authorized to read or write information directly from the FamilyTreeMaker database 

files.   Therefore, you will first need to export a GEDCOM file from FamilyTreeMaker that will 

serve as a snapshot of the FamilyTreeMaker database.   You can update that snapshot at any time by 

performing a new export from FamilyTreeMaker to the same filename and location.    

Clooz will produce GEDCOM files designed to work with FamilyTreeMaker when a GEDCOM file 

produced by FamilyTreeMaker in the Clooz External File Links list has be set as the Primary 

external file.   If a GEDCOM file produced by any program other than FamilyTreeMaker is selected 

as the Primary external file, Clooz will export the data to a more generic GEDCOM format. 

Immediately after clicking the Export button on the Document Export form (or Data Transfer 

Manager form), you must first select the name of the GEDCOM file which will be created to contain 

the exported information.   

 

Figure 127  GEDCOM Save As Window (for FamilyTreeMaker) 

You are now ready to import this GEDCOM file into FamilyTreeMaker.   If you are creating a new 

FamilyTreeMaker database, you use the Import command (File menu).   Otherwise, use the Merge 

command on the FamilyTreeMaker File menu. 
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Figure 128  FamilyTreeMaker File Menu 

You then select the GEDCOM file to be used (select the file created by Clooz). 

FamilyTreeMaker will then perform the GEDCOM merge and open its Merge Wizard.   You will 

normally want to include all the individuals and merge matching individuals (the default settings). 

 

 

Figure 129  FamilyTreeMaker Merge Wizard 

 

The Merge Wizard will then present you with a list of all the new and/or matching people in the 

GEDCOM (right side) and existing FamilyTreeMaker database (left side).    Pay close attention to 
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the details here before proceeding with the merger, and use the buttons at the top of the window to 

make changes in the selection of people you are merging the new data with. 

 

Figure 130  FamilyTreeMaker Merge Review Page 

At this point the FamilyTreeMaker database should now contain all the data transferred from Clooz 

and placed it in the appropriate locations.   If you are attempting to keep RIN values from 

FamilyTreeMaker synchronized with Clooz, you will need to export a GEDCOM file from 

FamilyTreeMaker (use the same GEDCOM file/location which you already have set as Primary in 

the Clooz External File Links list).   This is the file serving as the snapshot of the FamilyTreeMaker 

database (not to be confused with the GEDCOM file created by Clooz to transfer data to 

FamilyTreeMaker).   This can be confusing, and is why it is suggested that you establish a standard 

GEDCOM file name/location for Clooz exports, and for the FamilyTreeMaker snapshot. 

Once you open the updated snapshot GEDCOM in the Data Transfer Manager, you can edit the RIN 

values column for the Clooz individuals (appearing on right side of form).   If you don’t normally 

care to display the FamilyTreeMaker RIN values on the Clooz list of people (main screen), then you 

do not need to go through these past few steps. 

Finally, you may find it helpful to turn on the display of record numbers for individuals in 

FamilyTreeMaker, so that you can reliably identify matching people with those in Clooz (where you 

can turn on the RIN column for the list of people).   In FamilyTreeMaker, go to the Tools menu, 

Options item.   In the Options window, go to the References tab, and turn on the check in the 

checkbox for “Use individual reference numbers”. 
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Family Historian 

Clooz interacts directly with the Family Historian data file in the same manner as with Legacy 

database files.   The desired Family Historian .ged data file must be “set as Primary” on the External 

File Links list.   All changes to the Family Historian file are made automatically once the Export 

button is clicked on the Document Export form.   The dialog window for opening Family Historian 

projects supports selection by project name, or specific files (as shown in the next figures).   There 

are also some important actions the user needs to take when working with Family Historian, which 

will follow below. 

 

Figure 131 - Selecting a Family Historian Project 

 

When no projects are saved within the Family Historian project folder (controlled by the user within 

Family Historian), the Browse function will need to be used to locate the desired file.   A file 

selection dialog window will appear, and the user can either search for Family Historian project 

files, or the actual data file, by selecting the desired file type (see Figure below). 

 

Figure 132 - Browse window for Family Historian files 
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Family Historian maintains its data in memory while a file is in use, therefore there are several 

actions required to ensure Clooz is always reading the latest data, and conversely, Family Historian 

uses any new data Clooz has inserted into the data file.   These actions are only of concern when 

both Family Historian and Clooz are working with the same Family Historian data file at the same 

time. 

When first beginning any import or export operation involving a Family Historian file, Clooz will 

remind you to first Save the Family Historian file.   By performing the Save function in Family 

Historian, the file on disk is updated with any new changes recently entered by the user. 

 

Figure 133 - Save file message for Family Historian 

 

After the export has been completed in Clooz, if Family Historian is running and using that same 

file, it will recognize the change when the active focus returns to that window.   The option then 

comes up within Family Historian to reload the data so the screens will reflect the new information 

in the disk file. 

 

Figure 134 - Reload Family Historian Data Window 

If an export is made by Clooz to Family Historian where the user has made recent changes that have 

not been saved in Family Historian, some loss of data is possible.   If the user first reloads the data 

from the disk file when the prompt occurs following the export, the previous changes in Family 

Historian will be lost.   If the user skips the reload and then saves the Family Historian data, then the 

exported data from Clooz will be lost.   In general, if you forget to Save recent changes prior to a 

Clooz export, it may be better to not reload Family Historian, and instead Save the Family Historian 
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data.  Then repeat the entire Clooz export.  It all depends on which set of data (the recent Family 

Historian changes or repeating the Clooz export) involves the most work. 
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Program Options 

In the Edit Menu there is a menu item to display the Clooz Options window.   The Options window 

allows you to control a number of ways Clooz performs certain actions.  The window contains a set 

of tabs relating to different categories of options. 

 

Startup and Exit Options 

 

Figure 135 - Startup and Exit Options 

The Open Database option allows you to have the previous database open automatically every time 

you start Clooz, or you have the choice to always pick a database when Clooz starts.  You can set the 

maximum number of “most recently used” files to any number from 0 to 10. 

Clooz maintains a record of who makes changes to data and when they make the changes.   This 

information appears at the very bottom of document forms.   The User Name is the name recorded 

for such purposes.   You can either use the previous user (most likely you) when Clooz starts (the 



 

Clooz 3 User Manual Program Options    123 

default choice), or enter a name each time.    To immediately change the name of the current user 

(which is shown at the bottom of the User Name box), click on the Change Current User button. 

The last option box controls the Exit process.   You can optionally have Clooz compact the database 

you are using, and even archive it (zip file format).   It is a good idea to do both, but it does extend 

the length of time required for shutdown of the program.   If you have a system-wide program 

backing up your files on a regular basis, the archive function may be turned off.   The compaction 

process helps to minimize the amount of wasted space which accumulates in the database.   Note that 

it is common for database access errors to occur when the compaction routine runs.   No need for 

alarm.   Your database is automatically put back to its original state if the compaction routine does 

not run correctly for any reason.   If you want to see all the errors, set the check in the Alert for 

compaction failures checkbox.   Otherwise, leave it off.   These issues are coming from software 

beyond Clooz’s control. 

 

Importing Options 
 

 

Figure 136 - Importing Options 

 

The importing options involve the handling of date reformatting, primarily when importing 

GEDCOM files.   Months can either be full names or abbreviated, and in all capital letters if desired. 
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Media Options 
Clooz provides an option for you to establish a root directory for holding your media files which are 

attached to documents.   The first entry establishes a general default for any new databases you 

create.   The bottom entry is the specific setting for the database file in use.   This root directory will 

allow the path names listed in the document forms to be abbreviated.    

 

 

Figure 137 - Media Options 

 

 

 

 

 



 

Clooz 3 User Manual Program Options    125 

 

Update Options 
Clooz performs automatic downloading of updates by default.   The user always has to approve the 

actual installation of the update. 

If desired, automatic updates can be disabled, and then the user will have to request them manually 

using the Check for Updates command on the Help Menu. 

 

 

 

Figure 138 - Update Options 
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Source Options 
Sources contain both a title (as in the title of a book), and a label (a more descriptive and complete 

identification of the item).    You have the choice of which of these (title or label) will appear in the 

various drop down list of Sources in Clooz. 

 

The other option under the sources tab applies to the document export function.   Some users prefer 

to always cite a source for the person’s name, as well as an event.   The checkbox for this action in 

the Document Export form will be unchecked by default to cite the source for the person’s name 

when the name in the document details matches the person’s name in their main record.   If the 

checkbox shown here in the Options form is checked, the source will be cited for the name 

regardless of whether it matches or not. 

 

 

 

 
Figure 139 - Source Options 
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Document Options 
Some users prefer Clooz warn them if they leave the Personal File # blank, or use the same value 

more than one time.   These are carry overs from version 2 of Clooz.   You can turn this feature on or 

off using the checkboxes in the Documents tab on the Options form. 

 

There are also several options available to control whether Clooz will automatically fill blank birth 

and death dates in a person’s record based on available data in a document when the document is 

being closed.   Birth, Marriage, and Death record types will warn the user the event date and an 

existing date for the same event in their person record do not match, and provide the option to update 

the vital record date (if the option is selected to perform that action). 

 

 

 

 
Figure 140 - Document Options 
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Census Options 
Not all users of Clooz are researching census documents in all of the countries supported by Clooz.  

The Census Options all you to hide a particular country on the Explorer Bar.   Existing census data 

in your data is not affected.   Likewise, all of the countries are listed under the Clooz menu item.   

Turn off the census for one of these countries just helps by having less buttons and clutter on Clooz’s 

main screen. 

 

 

 
Figure 141 - Census Options 
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Clooz Customer Support 

You can find answers to problems or questions and more Clooz information here. Technical support 

is complimentary if you have registered your copy of Clooz.  

Support from Ancestral Systems, LLC, the owner of Clooz, is available by: 

 The Clooz Knowledge Base on the World Wide Web contains new error messages, solutions 

to common problems.  Check this page first at http://www.clooz.com/support/knowledge-

base.html to discover things you can do to solve your issue yourself. 

 E-mail support@clooz.com. The best option for problems and questions you can’t solve from 

the manual or our website. 

 Clooz Mailing List for users is where we share ideas about filing, organizing, and using 

Clooz or anything else that pertains to the program.  To subscribe to receive every e-mail 

when sent, send an e-mail to clooz-l-request@rootsweb.com, or for the digest version (this 

reduces the amount of e-mails you receive if the list gets active), send an e-mail to clooz-d-

request@rootsweb.com. Do not put anything in the subject line of your e-mail, and only put 

the word “subscribe” (no quotes) in the body of your message. Turn off any signatures that 

you have in your e-mail program. You’ll receive an e-mail back acknowledging your 

subscription with instructions on how to unsubscribe if you so desire. When you want to send 

a message to the list, address it to clooz-l-request@rootsweb.com. 

 Sign-up for the Clooz Newsletter on the Clooz.com homepage. 

 Write a letter to: 

Ancestral Systems, LLC 

9911 Bexar Road 

Somerset, TX  78069 

USA  

 

Our guarantee 
 

If you purchased the CD version of Clooz from Ancestral Systems LLC, and if you are not 

completely satisfied with Clooz within 30 days of purchase, return the entire package for a full 

refund, exclusive of postage and handling, to: 

Ancestral Systems, LLC 

9911 Bexar Road 

http://www.clooz.com/support/knowledge-base.html
http://www.clooz.com/support/knowledge-base.html
mailto:support@clooz.com
mailto:clooz-l-request@rootsweb.com
mailto:clooz-d-request@rootsweb.com
mailto:clooz-d-request@rootsweb.com
mailto:clooz-l-request@rootsweb.com
http://visitor.r20.constantcontact.com/d.jsp?llr=99clijjab&amp;p=oi&amp;m=1109486046042
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Somerset, TX  78069 

USA  

 

If you only purchased the download version of Clooz from Ancestral Systems LLC, and if you are 

not completely satisfied with Clooz within 30 days of purchase, email support@clooz.com for a full 

refund. 

If you purchased Clooz from a vendor and are not satisfied, you’ll need to check with the vendor for 

their return policy. 

 

Software license for Clooz 
 

CLOOZ End User License Agreement 

CAREFULLY READ THE FOLLOWING LICENSE AGREEMENT. BY CLICKING ON THE "I 

ACCEPT THE TERMS IN THE LICENSE AGREEMENT" BUTTON, YOU ARE CONSENTING 

TO BE BOUND BY AND ARE BECOMING A PARTY TO THIS AGREEMENT.  IF YOU DO 

NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, CLICK THE " I DO NOT 

ACCEPT THE TERMS IN THE LICENSE AGREEMENT" BUTTON, AND, IF APPLICABLE, 

RETURN THIS PRODUCT TO THE PLACE OF PURCHASE FOR A FULL REFUND. 

License Grant 

"You" means the person or company who is being licensed to use the Software or Documentation. 

"We," "us" and "our" means Ancestral Systems, LLC, 10900 South Stonelake Blvd., Ste. A-320, 

Austin, TX  78759.   

We hereby grant you a nonexclusive license to use one copy of the Software on any single computer 

for your own business or personal purposes.  In return, you agree to use the Software only on your 

System, on its temporary replacement, or on a subsequent System that replaces your System.   You 

are granted permission to use the Software on up to four Systems personally owned by you. 

Title 

We remain the owner of all right, title and interest in the Software and related explanatory written 

materials ("Documentation").  

Archival or Backup Copies 

You may copy the Software for backup and archival purposes, provided that the original and each 

copy is kept in your possession and that your installation and use of the Software does not exceed 

that allowed in the "License Grant" section above. 

mailto:support@clooz.com
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Things You May Not Do 

The Software and Documentation are protected by United States copyright laws and international 

treaties. You must treat the Software and Documentation like any other copyrighted material—for 

example, a book. You may not: 

 copy the Documentation (other than for your own personal use in reading the 

documentation), 

 copy the Software except to make archival or backup copies as provided above, 

 modify or adapt the Software or merge it into another program, 

 reverse engineer, disassemble, decompile or make any attempt to discover the source code of 

the Software, 

 place the Software onto a server so that it is accessible via a public network such as the 

Internet, or 

 sublicense, rent, lease or lend any portion of the Software or Documentation. 

Transfers 

You may transfer all your rights to use the Software and Documentation to another person or legal 

entity provided you transfer this Agreement, the Software and Documentation, including all copies, 

updates and prior versions to such person or entity and that you retain no copies, including copies 

stored on computer. 

Support 

We agree to provide you with free e-mail support in the installation and use of the Software  by 

writing  support@clooz.com.  This support is effective from the date you purchase the Software. 

Limited Warranty 

We warrant that for a period of 90 days after delivery of this copy of the Software to you: 

 the media on which this copy of the Software is provided to you will be free from defects in 

materials and workmanship under normal use,  

 the user manual and documentation provided with the Software are substantially complete 

and contain the information we consider to be necessary for the use of the Software, and 

 the Software will perform in substantial accordance with the Documentation. 

mailto:support@clooz.com
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We do not warrant that the functions of the Software will necessarily meet your requirements, or that 

operation of the Software will in all cases be uninterrupted or error-free.  We do not warrant 

Software that has been altered or modified by anyone other than us.   Any modifications of the 

Software made by you or anybody other than us, will void our warranty responsibilities.  You agree 

that this warranty does not require us to customize the Software, develop new features, or modify the 

Software for specific computer hardware. 

To the extent permitted by applicable law, THE FOREGOING LIMITED WARRANTY IS IN LIEU 

OF ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, AND WE 

DISCLAIM ANY AND ALL IMPLIED WARRANTIES OR CONDITIONS, INCLUDING ANY 

IMPLIED WARRANTY OF TITLE, NONINFRINGEMENT, MERCHANTABILITY OR 

FITNESS FOR A PARTICULAR PURPOSE, regardless of whether we know or had reason to know 

of your particular needs. No employee, agent, dealer or distributor of ours is authorized to modify 

this limited warranty, nor to make any additional warranties. 

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR 

INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT 

APPLY TO YOU. 

Limited Remedy 

Our entire liability and your exclusive remedy for breach of the foregoing warranty shall be, at our 

option, to either: 

 return the price you paid, or 

 repair or replace the Software or media that does not meet the foregoing warranty if it is 

returned to us with a copy of your receipt. 

IN NO EVENT WILL WE BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 

LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL 

DAMAGES ARISING FROM THE USE OR THE INABILITY TO USE THE SOFTWARE 

(EVEN IF WE OR AN AUTHORIZED DEALER OR DISTRIBUTOR HAS BEEN ADVISED OF 

THE POSSIBILITY OF THESE DAMAGES), OR FOR ANY CLAIM BY ANY OTHER PARTY. 

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR 

INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT 

APPLY TO YOU. 

Term and Termination 

This license agreement takes effect upon your use of the software and remains effective until 

terminated. You may terminate it at any time by destroying all copies of the Software and 

Documentation in your possession. It will also automatically terminate if you fail to comply with any 

term or condition of this license agreement. You agree on termination of this license to destroy all 

copies of the Software and Documentation in your possession. 
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Confidentiality 

The Software contains trade secrets and proprietary know-how that belong to us and it is being made 

available to you in strict confidence. ANY USE OR DISCLOSURE OF THE SOFTWARE, OR OF 

ITS ALGORITHMS, PROTOCOLS OR INTERFACES, OTHER THAN IN STRICT 

ACCORDANCE WITH THIS LICENSE AGREEMENT, MAY BE ACTIONABLE AS A 

VIOLATION OF OUR TRADE SECRET RIGHTS. 

General Provisions 

1. This written license agreement is the exclusive agreement between you and us concerning the 

Software and Documentation and supersedes any prior purchase order, communication, advertising 

or representation concerning the Software. 

2. This license agreement may be modified only by a writing signed by you and us. 

3. In the event of litigation between you and us concerning the Software or Documentation, the 

prevailing party in the litigation will be entitled to recover attorney fees and expenses from the other 

party. 

4. This license agreement is governed by the laws of the State of Texas. 

5. You agree that the Software will not be shipped, transferred or exported into any country or used 

in any manner prohibited by the United States Export Administration Act or any other export laws, 

restrictions or regulations. 
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Converting from Clooz 1.x 

If you own an version 1.23 or earlier of Clooz, you’ll want to convert your version 1.x database to 

version 3.  Instructions for doing so are under “Database Creation or Conversion” in the table of 

contents. It is strongly suggested that you read this before converting to ensure that your data gets 

placed properly within Clooz 3. Once you’ve got your database converted, there are some 

housekeeping items that you’ll want to pay attention to. 

Documents and census substitutes 
Several new document templates have been added in the 

Document category. These are: birth record, deed, marriage 

record, naturalization, early and later passenger lists, and the 

SSDI (Social Security Death Index). There is also a new 

category called Census Substitutes that contains some templates 

that you might have used a generic document template for in an 

earlier version of Clooz: tax record and voting list.  For these 

new templates, Clooz will look at your Event list in your1.x 

database to decide where to put your records. If, for instance, 

you added something to the birth event name, such as “Birth 

Smith,” Clooz won’t know to put those entries in the birth 

record template, so they will come in as generic documents. 

The easiest way to take care of this problem is to fix the events 

in your 1.x database and convert again. You can do this in 

Clooz 1.x by clicking on Edit Lists, and then choosing Events.   

 

Here are some helpful hints on the events that Clooz is looking for: 

• If you used event descriptions that came in Clooz 1.x for birth and marriage, then those 

documents will open up correctly as birth and marriage records in Clooz 3. 

• Most land records will convert into the deed template if the event you used in 1.x was  

something containing “land,” “deed,” or “mortgage.”   If your land records don’t convert into 

the deed template, you might want to change the event in your 1.x database to “deed” and 

reimport. 

• If you have naturalization records in Clooz 1.x, in order for them to import into the 

naturalization template, they need to have the event called either “naturalization,” “naturalize,” 

or “citizenship.” 

• For passenger lists, Clooz will import the events “passenger list,” “ship passenger list,” or 

“customs list” into the early passenger list template. 

• If you have any SSDI entries in Clooz 1.x, they will import into the SSDI template if they 
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have the event as either “SSDI” or “Social Security Death Index.” The event must be either of 

the choices and not something like “Social Security,” which Clooz will not recognize for this 

template. 

• Tax records will be imported into the Census Substitutes tax template if you used “tax” as the 

event name. 

• Any voting lists or records you might have entered into Clooz 1.x will be imported into the 

voting list template in Census Substitutes if you used an event that started with “vot” or the 

word “poll.” 

 

In Clooz 3.0, the specific events that the program needs will be generated by the forms when they are 
opened.  So, you don’t need to worry as much about tampering with your event names. 

 

Photos 
A couple new fields were added to the Photo template (which is now found in the Images category). 

You can now record a subject for a photo (which often will be the same as the event in the photo, but 

not always). You can also record the size of the image. You may want to take some time to update 

your photos with this new information. 

Before converting, you might want to check over your photo records in Clooz 1.x to make sure that 

you have the correct paths to images.  Or, if it’s too much trouble typing in the path and it’s 

incorrect, it’s easier to delete the path from the photo template in 1.x and then link the image using 

Clooz’s better image linking ability, described in the Images section of this manual. 

 

Sources 
Some new source entries were created for you during conversion. These will need your attention.  In 

versions of Clooz before 2.0, census and photo records didn’t have source entries. 

The information about these records was on the input screen.  In order to standardize data input in 

Clooz, all templates now are set up similarly and require source input onto source templates. 

Therefore, during conversion, Clooz created census and image sources for you, and arbitrarily gave 

them titles. Census records were given a title such as “1870 US Census 002” and were converted as 

Document sources. The source title for photos was taken from the description field, and images were 

converted as Image sources. You should spend some time making these sources conform to your 

style of citing sources. Additionally, since Clooz didn’t know what type of source your existing 

sources were, they were all (except censuses and photos) converted as Book sources. You should go 

through each imported source and select the correct source type, based on descriptions on the 

Sources pages in this manual. 
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Repositories 
The repositories that you had listed on the source template in Clooz 1.x will be imported into Clooz 

3.  You will find them listed in the Repository category on the Clooz explorer bar.  If you want to 

record the address and Web information for your repositories, you’ll need to edit each one to add this 

information, as it was not brought over in the conversion. The reason is because the repository 

address field in Clooz 1.x allowed you to enter a full address all in one field, but Clooz 3 has 

separate fields for each piece of information about a repository. 
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